Each Proposal Pack is a set of pre-written templates for all of the common sections of a proposal, business plan or other complex business document usable by virtually any business.

The pack also includes completed samples to help guide you in creating your own unique proposal, business plan, study or other business document.

https://www.ProposalKit.com

By Proposal Kit, Inc. Copyright 1997 - 2019. All rights reserved.
Copyright 1997 - 2019 by Proposal Kit, Inc. All rights reserved.

This documentation may not be copied or distributed without the express written permission of Proposal Kit, Inc.

Proposal Kit, Inc. makes no warranty and accepts no responsibility for suitability of any materials to licensee’s business. Proposal Kit, Inc. assumes no responsibility or liability for errors or inaccuracies. Licensee accepts all responsibility for results obtained. Accent graphics included in Proposal Pack templates are not intended as company logos and any resemblance to any existing trademarks or logos is purely coincidental.

Adobe Illustrator, Adobe Acrobat and Adobe Photoshop are trademarks of Adobe Systems Incorporated. Macintosh and Apple are registered trademarks of Apple Computer Inc. All other products and brands are trademarks of their respective holders. Proposal Kit, Inc. makes no claim to any such marks willingly or otherwise.
# TABLE OF CONTENTS

What’s New in V18.2? ................................................................................................................. 6  
What is “Proposal Pack”? .......................................................................................................... 52  
Benefits .................................................................................................................................... 54  
5 Minute Quick Start (READ FIRST) ...................................................................................... 55  
Where are the Editable Templates and Samples? ................................................................. 60  
What is Included? ..................................................................................................................... 62  
How do I use it on a Mac (or on Windows w/o the Wizard)? ........ 66  
Anatomy of a Proposal ............................................................................................................ 68  
Proposal Writing Primer .......................................................................................................... 75  
How to Select Templates: The Top 5 / Top 40 Rule ............................................................. 82  
Frequently Asked Questions .................................................................................................... 85  
Requirements for Use .............................................................................................................. 88  
How do I use it? ....................................................................................................................... 90  
How do I Insert my Own Logo? ............................................................................................... 92  
How do I Create Custom Bullet Points? ................................................................................. 93  
How do I Add a Title Page Background Graphic? ................................................................. 95  
How do I Add a Watermark Background Graphic? ................................................................. 101  
How do I use the Calculator Spreadsheets? ......................................................................... 105  
How do I Edit the Samples? .................................................................................................... 107  
What are Mail Merge and Tags? ............................................................................................ 109  
I Wasn’t Told What to Write, Where do I Start? .................................................................. 116  
How to Write a One Page Proposal ....................................................................................... 118  
How to Write a Services Sales Proposal ............................................................................. 120  
How to Write a Product Sales Proposal ............................................................................. 121  
How to Write a Quote, Bid, or Short Contract ..................................................................... 122  
How to Write a Proposal for a Project ................................................................................. 123  
How to Write a Grant Funding Proposal ............................................................................. 124  
How to Write a Business Plan Funding Proposal ............................................................... 125  
How to Write a Business Opportunity Proposal ................................................................. 126  
How to Write a Resume ......................................................................................................... 127
WHAT’S NEW IN V18.2?

- Updated the PageHeader_NOTEXT.png, Project_NOTEXT.png and Description_NOTEXT.png graphics to remove extra white space after the logo. This is to support a new Wizard software feature that will swap out graphic versions of page chapter headers and Title Page graphics with editable text but still retain the logo design theme graphic.

- Fixed a grammatical error in the instructional text in a couple templates (Contract and Terms, Terms and Conditions).

- Updated the text in the Sources of Funds template so the Wizard can detect and delete the red instructional text.

- Increased width of unit price and extended price and total columns in QuoteWerks alternate layout files to accommodate larger dollar amounts without wrapping.

WHAT’S NEW IN V18.1?

- Updated all the cost related chapter templates to adjust the table sizes to look better when used with page borders.

- Left aligned header text in all the cost related chapters to make the tables display consistently with tables in other templates.

- All the photo designed Proposal Pack design themes have been updated to separate out individual photographs in the Title Page and Back Page as individual picture objects. This is coupled with a new feature in the Expert Edition of the Wizard software that allows you to have the Wizard swap out any or all of the stock design photographs with your own by just making a new image and saving it in the Wizard’s MyGraphics folder with the appropriate name.
The Title Page, Back Page and Watermark-Body templates have been updated in every Proposal Pack to remove hidden legacy Word shape objects that could cause the ordering of some shapes to be out of place when using some Expert Edition features such as generating documents for use with QuoteWerks or using some of the Expert Edition custom branding features.

The Title Page templates in all bundled Title Page Packs that come included with Proposal Pack and Proposal Kit Professional or that are purchased separately have also been updated to remove hidden legacy Word shape objects.

The V18 conversion of all templates from legacy Word .doc formats to current Word .docx formats uncovered an obscure Word bug in the templates that caused the ZOrder variable to be invalid numbers in some cases. While this normally does not cause a problem, in some cases such as turning on Expert Edition features to import custom graphics or generate documents for use in 3rd-party systems the ZOrder bug could cause shape objects to change their ordering and go behind or in front of other shapes out of order. This update resets the ZOrder to correct values in all Title Page and Back Page templates. This only affected a small number of more complex Proposal Pack design themes however all of them have been updated.

Word icons have been updated to match the latest updates from Microsoft.

Alternate versions of cost table layout templates added for use with QuoteWerks.

Minor updates to instructional text wording in some templates.
Minor updates to URLs in the browser interface.

WHAT’S NEW IN V18?

All Word documents have been converted from the legacy Word 2003 .doc format to the current Word .docx format.

All Excel spreadsheets have been converted from the legacy Excel 2003 .xls format to the current Excel .xlsx format.

The Wizard software has been updated to remove all legacy Word 2003 support and now only works with the current Word and Excel file formats.

WHAT’S NEW IN V17.1?

All templates have the Proposal Kit Custom 1 to 9 Word styles and the Lite styles (only used in a handful of design themes with dark Title Page backgrounds) added for consistency. This means that to use the custom Word styles in older Proposal Pack design themes you do not need to manually add them to the templates first using the Preferences Font screen.

The text blocks in some Proposal Pack design theme Back Page and Title Page have been enlarged to accommodate using larger custom font types without the text falling outside the bounds of the enclosing text box that would then have to be manually resized.

The Setup.ini file that used to only be used in the Windows .exe version of the installer to help the Wizard configure any Proposal Packs design themes has been put into the .zip file versions to help support Windows 10 S installs of the Wizard using the .zip file Proposal Pack installers.
Added a new ReadMe.PDF to the root of the Proposal Packs to explain to users on all platforms that files for multiple platforms (i.e. Mac and Windows) are included now to help support multi-platform installs using the same .zip files. You can disregard any files you see for other platforms, they are not all intended for use on all platforms. This allows us to have Mac, Windows and Windows 10 S users all downloading the same .zip files.

WHAT’S NEW IN V17?


- All other existing Excel spreadsheets have been expanded with a considerable amount of new material. The number of line items available has been expanded, many new calculations have been added and for the cost summary and related spreadsheets 9 additional sheets to handle different types of situations have been added to reduce the amount of customization needed.

- 60 of the Proposal Pack templates (the ones that match the Excel spreadsheets) have all been updated to match the changes to the spreadsheets. Also new tags have been added that correspond to rows and columns in the spreadsheets. These new tags are to support the Proposal Pack Wizard features that will optionally create dynamic links between the Excel spreadsheets and your assembled documents.
35 new sample proposals with over 550 pages of new content have been added. There are now 200 total sample proposals with over 2400 total sample pages included.

- Disaster Preparation and Training Sample Proposal
- Orphanage Non-Profit Funding Sample Proposal
- Vacation Destination Resort Sample Proposal
- Awareness and Sensitivity Training Proposal Sample
- Bed and Breakfast Hospitality Sample Proposal
- Civil Engineering Construction Sample Proposal
- Commercial Property Rental Sample Proposal
- Dental Services Sample Proposal
- Equipment Maintenance and Repair Sample Proposal
- Equity Investment Sample Proposal
- Executive Personal Assistant Sample Proposal
- 3D Printing Prototyping Services Sample Proposal
- Drone Delivery in Disaster Area Sample Proposal
- Artificial Intelligence Project Sample Proposal
- Call Center Startup Funding Sample Proposal
- Political Action Committee (PAC) Sample Proposal
- Restaurant Kiosk Automation Sample Proposal
- Accounting Request for Proposal (RFP) Sample
- Transportation Request for Proposal (RFP) Sample
- Smart Home Automation Project Sample Proposal
- Trash and Waste Pickup Services Sample Proposal
- Woodworking Contractor Services Sample Proposal
- Heavy Equipment Leasing Sample Proposal
- Intellectual Property Licensing Sample Proposal
- Interior Decorator Design Services Sample Proposal
- Reuse of Government Land Sample Proposal
- Limousine Transportation Services Sample Proposal
- Expression of Interest for Mining Sample Proposal
- Motivational Speaker Sample Proposal
Movie Pitch Sample Proposal
Printing and Signage Services Sample Proposal
Public Relations Services Sample Proposal
Robotics Automation Project Sample Proposal
Safety Plan Sample Document
Security Plan Analysis Document

Editable Word versions of all sample content are now included for use by the Wizard software. This allows you to import the content of any Sample Proposal seamlessly into any one of our hundreds of Proposal Pack design themes. The editable Word version content has also had all name/address and other contact information replaced with mail merge data tags making it easier to create a customized version of any sample with just a click of a button.

Increased the number of licenses from three to five per purchased license.

Updated the HTML organizer with more readable fonts and updated graphics.

Minor manual updates.

Minor cosmetic updates to some templates including resizing some text boxes.

Added a reminder to the Windows installer that the Wizard software is a separate installer that requires Word for Windows to be installed first plus checks to see if Word is installed.

Samples are now sorted alphabetically in the desktop organizer.

WHAT’S NEW IN V16?
Over 380 pages of new material have been added to Proposal Pack (new templates, spreadsheets, instructional material). This version is one of the largest upgrades we have put out for Proposal Pack in 18 years of updates. Just like last year - more material was added just to this one upgrade than other proposal solutions include in their entire products.

With the new content and cover designs each Proposal Pack now contains over 4600 pages of content.

Browser interface has had font sizes increased for easier readability.

3 new calculator spreadsheets have been added (47 total spreadsheets): Payment Terms Calculator, Marketing Budget Calculator, Advertising Budget Calculator.

Added 25 new subcategories of templates (158 total subcategories). The subcategories provide a way to locate templates based on usage.

Added 380 new proposal templates increasing the total number of templates to over 2000. Templates added: What is New, One-on-One, We Understand You, From the CEO, Preamble, Scope of Work, Key Points, Premise, We Need Your Help, Starting Up, Before Getting Started, Shaping the Future, Raising the Bar, Game Changer, Guide for Beginners, Back to Basics, Perfect Fit, Call for Papers, Fringe Benefits, Mutual Benefits, Deliverables, Key Performance Indicators, Sequencing, Rotation, Playbook, Predictive Analytics, Interpretation, Implementation, Navigation, Reverse Innovation, Future Proofing, Readiness, First Response, Site Selection, Counter-terrorism, Weaponization, Enrichment, Adjustments, Accounts Management, Property Management, Case Management, Capture, Market Research, Trend Setting, Evangelism, Hiring,
WHAT’S NEW IN V15?

Over 600 pages of new material have been added to Proposal Pack (new templates, spreadsheets, samples, instructional material). This version is the largest upgrade we have put out for Proposal Pack in 17 years of updates. Just like last year - more material was added just to this one upgrade than other proposal solutions include in their entire products.

Added 4 more pre-assembled documents (7 total): Resume, Non-Profit Support Proposal, Short Services Contract and Feasibility Study. Pre-assembled documents are built from the individual library of templates included in Proposal Pack and are meant for use by people who are not using the Wizard assembly software.

With the new content and cover designs each Proposal Pack now contains over 4300 pages of content.

4 new calculator spreadsheets have been added (44 total spreadsheets): Complexity Cost Calculator, Debt Service Coverage Calculator, Depreciation Calculator and Return on Assets Calculator.

More niche proposal writing how-to articles are now integrated into the Proposal Pack. These articles are on-line and linked to directly from the Proposal Pack materials.

10 new sample proposals have been added (165 total sample proposals).

Animal Rescue Shelter Sponsorship Sample Proposal
### Added more pages of content to existing sample proposals.

### Added 25 new subcategories of templates (125 total subcategories). The subcategories provide a way to locate templates based on usage.

### All Proposal Pack templates with graphic page headers have been updated to include the hidden TC Fields in front of the chapter header graphics. In the past the Wizard software added this during document assembly. By adding the TC Fields to the chapter templates makes it easier to paste in chapters manually into a pre-assembled document and have them automatically show up in the Table of Contents.

### Cleaned up formatting in the Word Styles in a few templates.

### Changed <<Fixed Rate>> mail merge tag to <<FixedRate>>.

### Added over 400 new proposal templates increasing the total number of templates to over 1650. Templates added: Everything You Need to Know, Did You Know?, Why Choose Us?, Things to Do, Notice to Responders, RFP Information Sheet, RFP Policies, RFP Questions, Overview, Description, Briefing, Preface, Requests, Solicitation, Justification, Copyright Page, What We Do, Preparing for Success, Driving Factors, Value Added,
WHAT’S NEW IN V14.2?

A new Back Page template has been added to each Proposal Pack with a custom full size page background design that compliments the front Title Page design. The new Back Page is useful for adding an ending page to a document and provides a more professional finish to a document. Non-logo Proposal Packs use shape objects that can be changed to match your own company logo color scheme.

5 new Title Page logos have been added to every logo theme Proposal Pack (31 total options). This allows you to change the "Proposal" graphic to these new titles: "Analysis", "Confidential", "Bill of Materials", "Annual Report" and "Prospectus"
More pre-assembled documents are included in each Proposal Pack for Mac users and Windows users who are not using the Wizard assembly software. Now you have a choice between a business proposal for selling products and services, a business plan for funding and a short quote document already pre-assembled and ready to start ending right 'out of the box'.

Every Proposal Pack now has a unique 5-color palette created for it that matches the logo design theme. The Proposal Pack for Any Business uses a default black, white and grey color scheme and the Proposal Pack for Government Grants uses a red, white, blue and black color scheme. Various elements of the templates (page borders, bullet points, fonts, pull quotes and tables) are designed to allow you to customize the 5-color palette manually or automatically using the Wizard software.

All templates have been updated to support new Wizard software features that enable the Wizard to better make changes to various parts of the documents during assembly of multi-page documents.

All templates have had their table cell colors, page borders, header fonts and bullet points modified to match each Proposal Packs new color scheme and logo design. This makes assembling documents manually easier and keeps the visual design consistent across all pages if the Wizard software is not used.

A number of templates now have a pull quote section with a colored background added to them. This allows you to add a high profile statement the users eye will be drawn to first. This adds an extra design element to your documents already built into the templates.
More help information has been added to the interface and manual.

Added a new manual chapter: How do I use it on a Mac (or on Windows w/o the Wizard)?

The interface has been updated to help new users get started faster by pointing users to either using the pre-assembled documents or using the Wizard software.

WHAT’S NEW IN V14.1?

- Interface updates for better Internet Explorer 10 support.
- 100 new Title Pages have been added to the bundled Title Page Pack Volume #1. The 5 designs in the Title Page Pack have each had 20 new color schemes added. This increase the number of available choices to better match the visual look you want to achieve.

WHAT’S NEW IN V14?

- Over 500 pages of new material have been added to Proposal Pack (new templates, spreadsheets, samples, instructional material). This version is the largest upgrade we have put out for Proposal Pack in 16 years of updates. More material was added just to this one upgrade than most other proposal solutions include in their entire products.

- With the new content and cover designs each Proposal Pack now contains over 3600 pages of content.

- Added a new manual chapter: How to Write a Request for Proposal (RFP)
Added a new manual chapter: How to Write Your Proposal in a Foreign Language

3 new calculator spreadsheets have been added (40 total spreadsheets): Price Structure Calculator, Your Investment Calculator, Bill of Materials Calculator.

The Wizard automation software has been split into 2 versions. Novice Edition is now included as a free addition to the Proposal Pack. The Novice Edition covers most people’s basic document assembly and automation needs. The Expert Edition is now available as a low cost upgrade which unlocks more advanced document automation features. The optional Wizard automation software component is only supported on the Microsoft Word for Windows platform.

More niche proposal writing how-to articles are now integrated into the Proposal Pack. These articles are on-line and linked to directly from the Proposal Pack materials.

30 new sample proposals have been added (155 total sample proposals).

- Aerospace / Aviation Services Sample Proposal
- Banking Services Sample Proposal
- Agricultural Grant Funding Sample Proposal
- Organic Farming Product Sales Sample Proposal
- Fashion Industry Sample Proposal
- Graphic Designer Sample Proposal
- Ranching Supply Sample Proposal
- Non-Smoking Property Management Sample Proposal
- Pharmaceutical Product Sales Sample Proposal
- Restaurant and Bar Funding Sample Proposal
- Request for Proposal (RFP) Sample
- Ranching Educational Grant Funding Sample Proposal
Security Services Sample Proposal
Welding and Fabrication Services Sample Proposal
Electronic Records Management Sample Proposal
Records Management Analysis Sample Proposal
Records Management Survey Analysis Sample
Event Party Planner Services Proposal (British/UK)
Event Party Planner Services Proposal (Spanish)
Event Party Planner Services Proposal (Portuguese)
Event Party Planner Services Proposal (Dutch)
Event Party Planner Services Proposal (Italian)
Event Party Planner Services Proposal (French)
Event Party Planner Services Proposal (German)
Event Party Planner Services Proposal (Romanian)
Event Party Planner Services Proposal (Russian)
Event Party Planner Services Proposal (Arabic)
Event Party Planner Services Proposal (Chinese)
Event Party Planner Services Proposal (Japanese)
Event Party Planner Services Proposal (Korean)

A translated version of one of the service sample proposals has been added for 13 different languages to help support the new multilingual translation features included in the latest version of Proposal Pack Wizard:

British(UK) English
Dutch
Spanish
Portuguese
French
German
Italian
Romanian
Russian
Arabic

Machinery, Security Devices, Rescue Systems, Rigging, Lighting, Instrumentation, Showroom, Signage, Housing, Furnishings, Keynote Speaker, Artists, Focus Group, Escorts, Customer Satisfaction, Polarization, Decision Process, Synchronicity, Ambiance, Decor, Appearance, Self-Sufficiency, Continuous Improvement, Visibility, Timing, Saturation, Utilization, Seasons, Reconstruction, Landscaping, Open House, Computer Aided Design, Tryouts, Auditions, Rehearsals, Eco-Friendly, Agriculture, Livestock, Moving Services, Nutrition, Social Services, Catering, Menu, Sweepstakes, Sports, Artists Statement, Merchant Processing, Ergonomics, Tuition, Capitalization, Recapitalization, Subsidizing, Hidden Costs, Relocation Costs, Price Structure, Return Policy, Royalties, Refinancing, Deposits, Findings, Durability, Consistency, Career Summary, Special Offers, Special Services, Gift Certificate, Recognition, Advertisers, Executive Support, Ambassadors, Trainers, Talent, Task Force, Preferred Provider, Hours Available, Core Values, Care Program, Position Statement, Photographs, Parking, Tips and Tricks, Questionnaire, Customer Survey, Metadata, Tab #1, Tab #2, Tab #3, Tab #4, Tab #5, Tab #6, Tab #7, Tab #8, Tab #9, Tab #10, Memo, Legend, Rate Decrease Notice Letter, Rate Increase Notice Letter

- Added over 40 new subcategories of templates (100 total subcategories). The subcategories provide a way to locate templates based on usage.

- Now that the creation of RFP's (Request for Proposal) has been expanded in the latest edition of the Proposal Packs this has been reflected in the sample proposals to illustrate another use of Proposal Pack.

- Updated the Table of Contents document with an example list of templates to use for an RFP.
Fixed cell formatting in the Purchase Order Calculator Spreadsheet.

WHAT’S NEW IN V13.1?

All 1000+ Proposal Pack templates have been reformatted to use a consistent set of Word Styles. Now you have the ability to instantly change all text in your proposals to a new font, color or size by modifying the Word Style’s instead of selecting and manually reformatting each paragraph by hand.

All 1000+ Proposal Pack templates were also reviewed and updated as needed to make the page formatting more consistent across all of the templates. This ensures that no matter what combination of templates you assemble the overall structure, layout and page design of the final assembled proposal will fit together consistently.

All 1000+ Proposal Pack templates are now updated with a custom set of pre-defined Word Styles that are identically defined across all templates and are also supported by the Proposal Pack Wizard. All templates have been scrubbed to remove old Word styles and all built-in Word Styles have been updated to ensure they are identically defined across all templates.

Added a new manual chapter: [How do I Customize my Proposals Fonts?](#)

WHAT’S NEW IN V13?

Over 300 pages of new material have been added to Proposal Pack (new templates, spreadsheets, letters, samples, instructional material).
A library of 500 custom Title Page cover backgrounds is now included with each Proposal Pack.

With the new content and cover designs each Proposal Pack now contains over 3100 pages of content.

5 new sample proposals have been added (for a total of 125 samples).

- Mining Industry Sample Proposal
- Pest Control Services Sample Proposal
- Information Packet Sample
- Software Product Sales Sample Proposal
- Youth Sports Program Sample Proposal

Many of the Proposal Graphics Packs have updated Title Page cover designs, custom bullet point logos and background body watermark graphics.

More content has been added to a number of existing Sample Proposals (Wedding Planner Sample Proposal, Basic Product Sales Proposal, Catering Sample, Event Planner Sample, and Construction Home Building Sample).

Added more Alternate / Relative document cross references to the organizer to help users find templates that are related to or alternates to a given template.

An online library of “how-to” articles has been added to our web site. These articles help tie together the library of proposal topics and Sample Proposals with more ideas for how to assemble specialty proposals. All of the Sample Proposals are now linked to related online articles making it easier to locate information specific to individual needs.
To make it easier to locate proposal topics for specialized situations the organizer now groups proposal templates in a variety of categories (i.e. event topics, logistics topics, security topics, healthcare topics, construction topics, and so on.)

4 new Title Page graphics have been added to support using the Proposal Pack for writing information booklets, manuals and other types of documentation. The graphics added are "Manual", "Information", "Instructions" and "Documentation".


WHAT’S NEW IN V12.1?

Minor cosmetic improvements have been made to the interface and installers.
Links to our online Tips, Tricks and Best Practices article library have been added to the interface to help users make better use of the template and sample proposal libraries when writing their own unique proposals.

Links to more specific online how-to articles have been added to many of the sample proposals to help users when writing their own unique proposals. The how-to articles help outline a wider variety of business situations.

The default "Project" graphic in the Proposal Pack title pages has been changed to "Proposal".

The bitmap graphics have all been converted to PNG format. The PNG format files are smaller and more portable across multiple platforms. Many of the new PNG graphics have also been converted to use transparent backgrounds so they can overlay on the new Title Page background graphics.

A new Bullet.png graphic has been added to each Proposal Pack's graphics folder. This graphic can be used to change bullet points (in any Word processor that supports custom graphic bullet points) to a graphic that fits the rest of the Proposal Pack design theme. To see how to use the new custom bullet graphics in your own proposals read the new manual chapter How do I Create Custom Bullet Points?

A new Watermark-Title.png graphic has been added to each Proposal Pack's graphics folder. This graphic is used in the new TitlePage2.docx template. This new Title Page design is not supported in all Word processors. If your word processor does not support watermark background graphics use the original TitlePage.docx file. To see how to use the new custom Title Page background graphic in your own proposals read the new
A new Watermark-Body.png graphic has been added to each Proposal Pack's graphics folder. This graphic is used to create a faded watermark background that is replicated across all pages of the proposal (except for the Title Page). This new page background watermark is not supported in all Word processors. To see how to use the new background watermark read the new manual chapter How do I Add a Watermark Background Graphic?

A new document (WatermarkExample.docx) has been added. This document illustrates how to improve your proposal's visual look by incorporating custom graphics as bullet points and how to incorporate a faded watermark background into the body pages of your document.

Many of the sample proposals have been updated to use the new custom bullet point, Title Page background graphic and the body watermark background graphic. Read the new manual chapters for how to add these to your own proposals.

Added a new chapter to the manual titled How to Search for Text Across Multiple Documents. This chapter gives tips on how to search multiple documents such as the entire library of sample proposals or multiple Word documents.

Added large yellow arrows pointing to the indexes of editable templates and samples on the organizer home page to help people locate the links to the documents faster.

WHAT’S NEW IN V12?
Over 300 pages of new material have been added to Proposal Pack (new templates, spreadsheets, letters, samples, instructional material). Each Proposal Pack now contains over 2300 pages of content.

15 new sample proposals have been added (for a total of 120 samples).

- Basic Product Sales Sample Proposal
- Product Manufacturer Sample Proposal
- Hotel Facilities Services Sample Proposal
- Advertising Campaign Services Sample Proposal
- Manufacturing and Distribution Sample Proposal
- Buying a Vending Franchise Sample Proposal
- Research Funding Request Proposal
- Website Advertising Offer Sample Proposal
- Vending Machine Placement Sample Proposal
- Insurance Coverage Services Sample Proposal
- Research Sample Proposal
- School Funding Request Sample Proposal
- Joint Venture Sample Proposal
- Investment and Brokerage Services Sample Proposal
- Equity Ownership Stake Sample Proposal

Added suggestions of templates to use to the Table of Contents and documentation for Research Proposals.

Added a drop down navigation menu to the home page of the Proposal Pack organizer for all Proposal Pack skins.

Added a Research Proposal category for the sample proposals with the 2 new Research Proposal samples included.
Updated the graphics in a few of the Proposal Pack skins for consistency.

Added notes to the first page of each sample proposal explaining the link to purchase the samples better and to remind users to scroll down the PDF document to read the entire contents of each sample proposal.

A number of templates were updated with more content: Cover Letter, Introduction, Executive Summary, Expected Results, Features, Project Deliverables, Services Provided, Mission Statement.

Added more Alternate / Relative document cross references to the organizer to help users find templates that are related to or alternates to a given template.

A number of templates were updated with formatting changes and minor corrections.

The Fax Cover Sheet now includes the Letterhead graphic in all Proposal Pack skins.

Added a separate "5 Minute Quick Start" document displayed when the Proposal Pack is first installed to help users get started faster.

The Proposal Pack organizers have been updated to remove JavaScript and older navigation methods. The organizers are now all updated to use Cascading Style Sheets (CSS).

Tips on how to move content from sample proposals to editable templates have been added to various parts of the organizer.
The references to the Proposal Pack Wizard INI files for government grant sample proposals have been changed from FileList8.ini to FileList11.ini.

Added a new chapter in the manual How do I Edit the Samples?

Added a new chapter in the manual Stay Out of Trouble Copying Proposal Examples

Added a new chapter in the manual How do I use the Calculator Spreadsheets?

Added a new chapter in the manual How to Write a Research Proposal

Added over 200 new proposal templates increasing the total number of templates to over 800. Templates added: Problem Statement, Message, Synopsis, Proposition, Intent, Purpose, Synthesis Statement, Context, Pros and Cons, Exposure, Economy, Take Action, Master Plan, Conversion Rate, Effects, Hypothesis, Triggers, Experiments, Requisitioning, Receiving, Commercialization, Preparation, Automation, Tactics, Streamlining, Allocation, Data Collection, Data Mining, Mapping, Delegation, Teamwork, Supervision, Communications, Registration, Renewal, Examination, Investigation, Searching, Diagnostics, Therapies, Screening, Processing, Mobilization, Productivity Improvement, Reinvention, Diversification, Trading, Customization, Modifications, Transformation, Support, Motivation, Recruiting, Outreach, Reproducibility, Due Diligence, Valuation, Risk Management, Succession Planning, Consequences, Closures, Accommodations, Project Analysis Overview, Facts, Knowledge, Research, Classifications, Identification, Scenarios, Commonalities, Priorities, Ratings, Calculations, Variables, Metrics, Pipeline, Channels, Storage,
WHAT’S NEW IN V11?

🔍 Over 300 pages of new material have been added to Proposal Pack (new templates, spreadsheets, letters, samples,

15 new sample proposals have been added (for a total of 105 samples).

- Business Growth Services Sample Proposal
- Health and Fitness Program Sample Proposal
- Electronic Medical Record System Sample Proposal
- Patent and Invention Licensing Proposal
- Legal Services Proposal
- Product Cost Savings Sales Sample Proposal
- Patenting New Technology Sample Proposal
- Franchise Selling Sample Proposal
- Government Contract Product Sales Sample Proposal
- Government Contract Service Sales Sample Proposal
- Selling a Web Site and Digital Assets
- New Sales Office Sample Proposal
- Charter School Educational Sample Proposal
- Sale of Business and Assets Sample Proposal
- Architectural Design Sample Proposal

Added suggestions of templates to use to the Table of Contents and documentation for Government Contract proposals.

The alphabetical listing of all templates in the organizer has been enhanced with easier to navigate features.

26 new financial calculator spreadsheets have been added for use with the financial templates.

The Budget category has been renamed to Financials.
Added a Financials Spreadsheets and Letters categories to better organize the templates.

The Methodology, Financial and Qualification categories have been split into multiple subcategories and the templates have been reorganized under the new subcategories to make them easier to manage.

Added links from each web page for the proposal templates to each of the Sample Proposals the template are used in to make it easier to find examples of completed content for many of the templates.

Spreadsheet templates have been moved into a new folder called "Spreadsheets" instead of locating them in the same folder as the Word document templates.

Added a new chapter **Boilerplate is Bad for Business – Templates without the Fluff** regarding the use of boilerplate text in templates and how Proposal Packs are designed to avoid problems with generic boilerplate text.

Added a new chapter **It’s All About Trust – Winning Proposals by First Winning Trust** regarding how Proposal Packs are designed to generate trust in the reader and why it is important to think with trust-based mind set when writing your proposals.

Added over 200 new proposal templates increasing the total number of templates to over 600. Templates added: Cover Sheet (Government Contracts), Customer Information, Importance, Getting Started, Forecast, Growth Areas, Observations, Market Study, Population, Accessibility, Improvement, Economic Impact, Solutions, Production Plan, Content Management Plan, Contingency Plan, Approval, Exercises, Negotiations, Representation, Modeling, Prototyping,
WHAT’S NEW IN V10.1?

15 new sample proposals have been added (for a total of 90 samples).

- Occupational Therapy Services Sample Proposal
- Transportation Shipping Services Sample Proposal
- Technical Resume Sample
- Executive Resume Sample
- Home Daycare Services Sample Proposal
- SEO Services Sample Proposal
- Music DJ Sample Proposal
- Manufacturing Process Improvement Sample Proposal
- Import Export Services Sample Proposal
- Franchise Purchasing Sample Proposal
- Feasibility Study Sample
- Electrical Contractor Sample Proposal
- Church Mission Shelter Sample Proposal
- Case Study Sample
- Auction Fundraiser Sample Proposal

- Added a new chapter to the manual for helping select documents [How to Select Templates: The Top 5 / Top 40 Rule](#)

- The product organizer has been completely replaced and updated with new graphics.

- Improvements to the Windows installer to help prevent problems when changing the default install folder.

- Overall, the entire product has been given a facelift with our new logo and graphic theme. The existing product content (templates, spreadsheets and samples) has not been changed.
WHAT’S NEW IN V10?

Over 300 pages of new material have been added to Proposal Pack (new templates, spreadsheets, letters, samples, instructional material).

Added an ROI Calculator spreadsheet to be used with the ROI template.

Added 25 new sample proposals (195 pages of content).

Most of the existing templates have been updated to cleanup some formatting issues, including removing extra blank pages at the end of many pages and making fonts consistent across all documents.

The Table of Contents has been updated to add all of the new templates.

Added referenced exhibits to the Contract and Terms template.

Fixed spelling error “supercedes” in Non-Disclosure Form (long form).

Improvements to this manual with automated Table of Contents and more hyperlinks connecting the content.

Added a manual chapter on the topic of Combining Cover Letter into a Master Proposal

Added a manual chapter on the topic of Creating an Automated Table of Contents

Added a video to the 5 Minute Quick Start (READ FIRST) chapter.
WHAT’S NEW IN V9?

Over 300 pages of new material have been added to Proposal Pack (new templates, checklists, samples, instructional material) adding over 60% more material to this version.


Added a proposal bid/no-bid decision checklist.

Added a government grant proposal development checklist.

Added a complete service level agreement to the Contract and Terms template.

15 general business sample proposals have been added.

10 Federal government grant sample proposals have been added.


The Table of Contents has been updated to add all of the new templates.

WHAT’S NEW IN V8.01?

To better support installation on Windows Vista, the install folder for Proposal Pack has been changed from c:\Program Files\ProposalKit to c:\ProposalKit. This change was made to prevent permissions problems from causing the user to have the Proposal Pack documents open in read-only mode after installing on Windows Vista.

WHAT’S NEW IN V8?

Added 63 new proposal templates increasing the total number of templates from 140 to over 200. Templates added: Cover Letter (Business Plan), Process Summary, Location Analysis, Goals and Objectives, Milestones, Merchandising, Architecture, Implementation Plan, Data Management, Schedule of Events, Maintenance Schedule, Certificates, Permits and Licenses, Legal Documents, Contingencies, Projections, Specifications, Performance Requirements, Future Funding, Project Budget, Monthly Budget, Annual Budget, Price List, Return on Investment, Financing, Consulting, Logistics, Listings, Comparison Chart, Research and Development, Awards and Achievements, Process Management, Administration,

- Added a proposal submission status follow-up request letter template.
- Added a new proposal/project task tracking spreadsheet.
- All Proposal Pack templates have been converted to standard Word format instead of RTF format. This has reduced the file sizes of the templates and resolved problems with some word processors that could not convert the old RTF format documents such as Word Perfect and Appleworks.
- Custom graphics editing services are now being offered.
- A "Quote" graphic has been added as a substitute for the default Title Page graphic titled "Project".
- The "Letterhead" graphic has been included in the PNG_Graphics folder named Letterhead.png.
- The Budget template has been changed to be company specific instead of project specific. A new "Project Budget" template (listed above) has also been added.
- The Table of Contents has been updated to add all of the new templates.
The Work Order and Work Order (with deposit) templates have been updated with new <<DeliveryDate>> and <<WorkOrder>> merge tags for use with the Proposal Pack Wizard.

5 new sample proposals have been added in Sample Proposal Collection Volume 5 bringing the total number of sample proposals included in each Proposal Pack to 25.

All Proposal Packs now use Times New Roman as the default body text for the various templates.

**WHAT’S NEW IN V7?**

Proposal Pack now supports grant funding proposals, business plan funding proposals and book publishing proposals in addition to general business proposals and resumes.


Added a “Business Plan” graphic for the Title Page for business plans.
Added the Proposal Tracking Spreadsheet for tracking the stages of your proposals.

Added 9 more blank templates.

The Table of Contents template has been updated to include the new templates.

The Table of Contents template also now includes a variety of example selections of templates for various types of proposals.

New Sample Volume #4 with 5 new sample proposals is bundled with all Proposal Packs. New samples illustrate grant writing, business plan funding, and book publishing proposals.

New chapters added to the instructions for how to use the template collection for technical business proposals, non-technical business proposals, grant funding proposals, business plan funding proposals, book publishing proposals and resumes.

Minor updates to some existing templates.

User interface improvements made to the navigation organizer.

WHAT’S NEW IN V6?

Updated Cover Letter, Inquiry Letter, Title Page, Work Order #1, Work Order #2 and Non-Disclosure (short and long) templates with a current date tag: <<CurrentDate>>.

Added new tag <<ProposalTitle>> to Title Page.

New Sample Volume #3 with 5 new sample proposals is bundled with all Proposal Packs. New samples illustrate product, service and resume proposals. Over 40 pages of new sample material added.

Changed default ordering of Opportunities, Executive Bio, Resume, RFP Cross Reference and Services Provided templates.

The Table of Contents document has been updated to include the new templates.

Added a Proposal Development Checklist.

Added a Post-Proposal Analysis Checklist.

Added new “Proposal” variation as an option to the standard “Project” graphic used in the Title Page document.

New version of the “Proposal Writing Primer” included in the documentation.

27 new graphics in .PNG format for the new templates have been added.

Removed redundant .EPS and .PSD graphics files.
Replaced Microsoft Word specific mail merge tags in all Proposal Pack styles with editable plain text tags for better support on all word processors.

**WHAT’S NEW IN V5.1?**

- The HTML organizer has been broken up into multiple pages and streamlined for easier navigation of the documents.
- Added a recommendation matrix page to the HTML organizer to assist in selecting documents for a proposal.
- Removed some Word only features (i.e. text boxes) from the Title Page and Non-disclosure (long form) documents to work better in other word processors.
- Sample Proposal Collections Volume 1 and Volume 2 are now bundled with each Proposal Pack installer to streamline the download and install process.
- Added Linux versions of the install files.

**WHAT’S NEW IN V5?**

- Added 15 new templates increasing the total number of templates from 57 to 72. Templates added: Executive Bio, Opportunities, Work Order (2 versions), Risk Analysis, Contingency Planning, Requirements, Products, System Integration, Payment Schedule, Project Constraints, Acceptance Criteria, Documentation Requirements, Interface Requirements, RFP Cross Reference.
- 14 new graphics in .EPS, .PSD and .PNG formats for the new templates have been added.
9 existing templates have been expanded with more content: Benchmark Results, Client Background, Industry Trends, Future Developments, Qualifications, Client Operations, Recommendations, Project Summary, Storyboard.

Updated non-disclosure forms (long and short versions).

2 Work Order agreements have been added. The full text of the agreements is included. Use the Work Order templates for small dollar projects to spell out the terms of the agreement. The Work Order templates are designed for product and service sales agreements.

A new Inquiry Letter template has been added. The Inquiry Letter is sent when inquiring about sending a proposal, as some companies will not accept unsolicited proposals. We hired an independent proposal writing firm to create an inquiry letter template based on what really works.

The Table of Contents document has been updated to include the new templates.

The Proposal Pack template collection has been reorganized into more categories to add even more structure to your proposal. This new organization is built into the Table of Contents, Proposal Writing Primer documentation, HTML organizer web page and the updated Proposal Pack Wizard add-on software.

Added links and information for the new add-on Proposal Pack Wizard software.

Added “Anatomy of a Proposal” section to the documentation.
Added an 11 page “Proposal Writing Primer” article to the documentation. Written specifically for Proposal Pack.

Windows download files were reduced by 5mb by using updated InstallShield installations.

WHAT’S NEW IN V4?

Added 10 new templates increasing the total number of templates from 47 to 57.

Added 5 new sample proposals bundled with each Proposal Pack.

Added more material to the “Tips and Tricks” section below.

Added more tags in the Resume and Benefits templates.

Reorganized the borders to allow printing on wider range of printers without having to manually readjust the page border settings.

WHAT’S NEW IN V3.1?

Added more documentation on combining documents, creating custom styles and adjusting optional page borders. No changes have been made to any templates.

Minor changes to formatting in some documents (colors and bullet point styles).

WHAT’S NEW IN V3?

Online tutorial and samples added: https://www.proposalkit.com/htm/help-center.htm
Added 14 new templates increasing the total number of templates from 33 to 47.

Added a web based desktop organizer web page for easy access to materials.

Added more documentation.

Added 36 new graphics with each Proposal Pack.

**WHAT’S NEW IN V2?**

More fields have been added to the data fields list. Specifically a Proposal Number used in the Title Page and a set of 10 custom fields.

20 new templates have been added.

More documentation, tips and tricks have been added to this guide.

A Proposal Number tag has been added to the Title Page template.

A number of new tags have been added to the Company History template.

New tags have been added to the References template.
WHAT IS “PROPOSAL PACK”? 

Each Proposal Pack is a set of pre-written templates for all of the common sections of a proposal, business plan or other complex business document usable by virtually any business. The pack also includes blank templates for creating your own custom pages with matching graphics easily.

Each set of templates and graphics have been professionally designed and is ready to use as-is. You can quickly create proposal frameworks from one page to hundreds of pages long.

For maximum flexibility in creating your own variations, we also include blank template files with look and feel matching graphics. Also included are original artwork files in both Adobe Illustrator (EPS) and Adobe Photoshop (PSD) versions ready to modify. If you do not have Illustrator or Photoshop, PNG versions of all template graphics are included with and without text so you can easily create your own variations with any graphics program.

Proposal Pack is designed to give you an easy to edit set of industry standard proposal templates without requiring expensive proposal automation software. We supply professionally designed and cost effective ready-made sets of editable documents with original artwork without the need for expensive automation software.

The benefits of high-end automation systems are mainly for large organizations, government contractors and large sales forces with centralized databases and dedicated IT departments. For virtually everyone else, these systems would be overkill and too expensive.
Rather than fill out a bunch of text boxes in a wizard style interface which just inserts your text into a Microsoft Word document you have to edit in the end anyway, we supply the pre-written professionally designed templates which support even more platforms than any other proposal and contract software. Just open the templates and insert your information in the locations provided. If you still feel the need for a high-end automated wizard piece of software, remember that no software however expensive, will write your whole proposal for you. You still have to write your company history, resume, portfolio, etc. You still have to interview your prospective client and research their company and needs. You still have to come up with the solution and put it in writing.


If used properly, our proposal templates can help make the difference in winning a proposal. Many factors determine who has the winning proposal. A professional looking client-centered proposal is one of those factors. Avoid the temptation to recycle old proposals by just changing the client name. A winning proposal requires some research and shows the client you understand their business and needs. Most often, you can reuse much of your company section and parts of past proposals. Once you have done a few proposals, new ones will get easier.
BENEFITS

- Cost effective

- One package works for technical, non-technical, product sales, services sales, grant funding, business plan funding, book publishing and resume proposals

- Can also be used to create consistent looking business reports

- Professionally designed

- Save time and money getting started

- Industry standard formats and layouts

- Immediately usable without any software setup or learning curve

- Completely extensible with original graphic artwork and templates

- Supports Windows, Mac and Linux

- Level the playing field against larger competitors
5 MINUTE QUICK START (READ FIRST)

Follow these steps to quickly set-up your first document.

This guide is for those not using the optional Wizard add-on software such as Mac users and those who do not have Microsoft Word.

No system, no matter how complex or expensive, will replace the job of writing your own content for your proposal, business plan or other complex business document. While thousands of pages of examples are also included be prepared to do some of your own writing.

The Proposal Pack templates and optional add-on Proposal Pack Wizard software will help automate the process of setting up a complete document ready to fill in the details.

ADDITIONAL ON-LINE TUTORIALS

ProposalKit.com/htm/proposal-pack-tutorial.htm
ProposalKit.com/htm/videos-pack-quick-start.htm
FOLLOW THESE STEPS

First - Install your Proposal Pack. If you are reading this manual you have already performed this step.

Second - Install the Proposal Pack Wizard. This step is optional and only used if you also have the required system and software for using the Proposal Pack Wizard. If you are using both a Proposal Pack and the Proposal Pack Wizard read the “5 Minute Quick Start” section of the manual that came with Proposal Pack Wizard instead of this quick start guide.

Third - Locate the documents by clicking the “Open Proposal Pack” icon. This icon is found on your Windows desktop and start menu. Mac and Linux users will find the file in the folder on your hard drive where you installed the Proposal Pack. This will open the Proposal Pack Desktop Organizer. Any references to the “Proposal Pack Organizer” or “Proposal Pack Desktop Organizer” are this red icon labeled “Open Proposal Pack ...”. You can locate this organizer by looking for the red icon on your desktop, or in your Start Menu (for Windows Users), or in the product install folder in a file named “OpenProposalPack.htm”.

Once you have opened the Proposal Pack organizer, click the links in the organizer home page titled “Pre-Assembled Documents”, “All Editable Templates” and “All Completed Samples” to find and open the documents. Clicking the links to the documents in the organizer will launch your Word processor or otherwise display the requested document for you to open manually. For example, from the Index page click
the “Cover Letter” link. This will take you to a description of the document and a link to the document. Now click the “Open Document” button or the text link to open the document.

The file names for the example above are in the Documents\Word (or Documents:Word if you are using a Mac or Documents/Word if you are using Linux) folder located where you installed the Proposal Pack product on your hard drive. You can also open the documents without using the Proposal Pack organizer by using the “Open” file option in your word processor and browsing to the folder on your hard drive where the documents are located.

- Cover Letter  
  CoverLetter.docx
- Title Page  
  TitlePage.docx
- Executive Summary  
  ExecSummary.docx
- Cost Summary  
  CostSummary.docx

Open a collection of templates using your word processor. For a very small document you can use the Cover Letter, Title Page, Executive Summary and Cost Summary templates (4 out of the large collection of included templates). Then add templates from the rest of the collection as you see fit. There are hundreds of templates to choose from. Read this chapter for tips on how to pick a small set of templates: [How to Select Templates: The Top 5 / Top 40 Rule](#).
Fourth - edit your templates to include the information specific to your client, company, proposed project, business plan, etc. This step is basic word processing using your own word processor. Your Proposal Pack also includes a large collection of completed samples. Look at the samples to help guide your selection of templates and how to fill in the blanks.

The samples include a wide range of situations including proposals, business plans, studies, resumes, grants and more.

Fifth - create a new folder on your hard drive to hold your new documents. You can save them anywhere on your computer. It is recommended you create a new folder for each project. Then, in your word processor, select “Save As” and save each of your templates you have edited to your new folder.

Sixth - print your documents to your printer or save them as Acrobat PDF files. Your proposal is now ready for delivery. If you are going to send your document electronically use the Acrobat PDF format. Many word processors have a save as PDF option.

Barring unexpected problems, reading documentation or using more advanced features of your word processor or graphics program you can create a template ready to start editing in just minutes.

If you use our add-on Proposal Pack Wizard many of the manual steps above such as selecting documents, merging contact information and creating client folders will be performed by the Wizard and will speed up the process even more.
The Proposal Pack templates are designed to be easy to follow and fill in the blanks with your specific details. They are designed with the concept of using lots of short text and bullet points. This has the following benefits:

- Faster proposal development for you.
- Easier to read and understand for your prospective client.

For proposal writers you should not try to design your project in the proposal. The proposal is an outline for the prospective client covering as many points as possible to get the job. Do not try to completely explain your solution in your proposal. You want to give enough information to win the proposal, but not so much information the client can figure out how to do it themselves or turn your work over to someone else.

Entire books are written on the topic of how to write a proposal or a business plan. If you are in a hurry to create something fast, remember that most deals are made because the parties trust each other. Read the Proposal Pack manual chapter titled It’s All About Trust – Winning Proposals by First Winning Trust for more tips.

Also make sure to read the Anatomy of a Proposal and Proposal Writing Primer sections of the documentation.
WHERE ARE THE EDITABLE TEMPLATES AND SAMPLES?

Your individual Proposal Pack files have been installed on your hard drive in the folder specified when you installed the Proposal Pack.

The editable templates are located in:

- [install folder] > ProposalKit > ProposalPack > [style name] > Documents > Word

The editable spreadsheets are located in:

- [install folder] > ProposalKit > ProposalPack > [style name] > Documents > Spreadsheets

The PDF sample proposals are located in:

- [install folder] > ProposalKit > ProposalPack > [style name] > SampleProposals

The actual operating system directory path will differ between Windows, Macintosh and Linux, however the directory path structure above will be the same across all platforms.

For example, if you purchased “Proposal Pack for Any Business” on Windows, the template folder would be:

- C:\ProposalKit\ProposalPack\AnyBusiness_1_v##\Documents\Word
There are four ways to open the Proposal Pack templates:

1) Click the links in the HTML organizer to launch your word processor and open the clicked document or to view the PDF samples. The HTML organizer is the link titled “Open Proposal Pack XXX” that was put on your desktop and start menu when you installed Proposal Pack.

Not all systems or web browsers are configured to be able to do this. If yours is unable to launch a file, see options 2 and 3 below. Your "office software" is whatever office or word processor application you use such as Microsoft Office/Word, iWork, OpenOffice.org, StarOffice, Word Perfect, Google Docs or Appleworks.

2) Using your desktop, browse to where you installed the Proposal Pack and find the "Documents" subfolder. Then double click your mouse on any document icon. Your default word processor will run and open the document.

3) Run your word processor program. Then select from the "File" menu, the "Open" option. Then browse as in step 2 above to locate the document to be opened. Then click the OK button.

4) Use our add-on Proposal Pack Wizard (Windows only) to open the Proposal Pack documents without having to browse your hard drive to locate them.
WHAT IS INCLUDED?

There are thousands of editable templates included in each Proposal Pack. Open the desktop organizer to view the entire list of included templates along with descriptions of each template, cross references to related and alternate templates and cross references to every completed sample which illustrates the templates in actual use.

Each Proposal Pack includes a complete set of graphics for use with the associated style. Each set of graphics is included in three different versions (EPS, PSD and PNG). Pick the set that best suits your development environment. Photo design theme packs will use JPG graphics for the front and back pages instead of PNG.

For direct inclusion in your documents, use the PNG versions as you may run into problems if you send original editable documents to other people with embedded PSD or EPS files.

Each Proposal Pack also includes a large collection of pre-written and pre-formatted templates useable by virtually any type of business following industry standard guidelines. Each set of templates are supplied in Word format supporting Windows, Mac and Linux and any word processor which can read the Word format such as Microsoft Word, Pages, iWork, OpenOffice, StarOffice, Appleworks, Google Docs and Word Perfect.

Your document can include any combination of these templates, and if you need a template for a specialized need you can use the supplied original graphics to create a matching header graphic. A short proposal for a small project may only include the cover letter,
executive summary and cost summary. If your document includes sensitive information you don’t want a competitor to see, add the non-disclosure template. For longer documents, add title page, table of contents and any other templates required. If you are responding to an RFP, only include sections the RFP states must be included. If you are sending an unsolicited proposal, or after a cold call, use whichever templates fit the needs of the client and project.

The “Table of Contents” template includes an entry for every one of the template files. Do not feel you need to fill all of them in. Delete the lines for the templates you are not going to use. You will probably never use all or even most of these templates in a single proposal. A small proposal may only use 3 templates, an average proposal may use 10 to 15, and an even larger proposal may use 100 or more. Pick the templates based on your needs, the client’s needs and the needs of the project. Our add-on Proposal Pack Wizard software includes a document selection wizard which can recommend a collection of templates to use and will create a custom Table of Contents for you.

Templates fall into five categories: Introduction, Client-Centered, Project-Centered, Your Company-Centered and Appendices. A good proposal will use a mix of all of these. A great proposal shows a heavier concentration on the client-centered and project-centered portions of the proposal. Your proposal needs to show that you understand your client’s industry, business and needs. This means you will have to do some legwork and research on each proposal to make it a client-centered proposal. The first part of the proposal is in the introduction templates, which include a more informal cover letter, title page, etc. Second are the client-centered templates that show you understand their industry,
company and needs. The third part is the project-centered set of templates. These are designed to show prospective clients you understand the problem and have a solution. At this juncture, do not give away too much information on how you plan to solve the problem. The last part of the proposal is the set of templates about your company. These can usually be duplicated for each proposal. This section is important because it shows your prospective client you know what you are doing and that you can deliver. The last part of the proposal is a collection of appendix templates. These are usually used for very large proposals with lots of technical details, acronyms and illustrations.

If you are new to proposal writing, we strongly urge you to read several books on this subject. These books go into much more detail on writing a client-centered proposal and proposal management. Recommended book resources can be found at:

https://www.proposalkit.com/htm/append.htm

Blank templates are also included to extend the list above for your own needs. For example, if you are creating a proposal and need a template for a new section called “Supply Chain Design”, you can create a matching graphic header using the original artwork graphics and the blank template.

Some proposals or RFP’s may require a template we provide, just with a different wording of the title. In this case change the title by altering the original graphic and inserting it back into the template. For example, to change the “Recommendations” template to read “Technical Design”, open the original artwork file, select the same font (or download the font from Adobe or whatever company created the font), edit the title, resave as a .PNG file, then insert the
new graphic back into your template. See the chapter on how to *Easily Create Your Own Graphic Style* for more detail.

For a very short proposal or small project proposal, you may only use the cover letter, title page, executive summary and cost summary. Add additional material to your proposals as you see fit. For a medium-sized proposal, you may add in the recommendations and portfolio. Longer proposals will use many templates.

There are no rules for which templates to use, only guidelines. Your final proposal will depend on your business, the client’s needs and business, the size of the project, whomever else you are competing against, etc.

If the type of page you find you need is not pre-written, use the original graphics files to create a new header graphic, insert the graphic into the blank template and create a whole new template.

These templates are common types of templates used in many proposals. If you read enough books on proposal writing and look at enough sample proposals, you can easily create thousands of variations on proposal section headers. With our original artwork and blank templates, you can easily create a custom proposal, professionally designed to match any of your needs.
HOW DO I USE IT ON A MAC (OR ON WINDOWS W/O THE WIZARD)?

The Proposal Pack is commonly used manually by both Mac users and Windows users who are not running our optional Wizard assembly software.

The most efficient way to get started is to open one of the pre-assembled documents included in each Proposal Pack. Open the Proposal Pack browser interface (the Open Proposal Pack Windows icon, or the OpenProposalPack.htm file in the root of the install folder) to open the pre-assembled documents and instructions on how to customize them using the rest of the editable templates in the Proposal Pack library. We have already pre-assembled a number of complex multi-page documents for you to get started with.

Many Mac users also have a Windows PC available for running business applications that are not natively supported on Mac computers. You can run our Wizard software on a separate Windows computer to assemble custom templates then copy the Wizard assembled templates to your Mac computer for editing. You can mix and match systems easily such as building your document in Microsoft Word for Windows, then copying to your Mac and editing it in Pages or Microsoft Word for Mac. Your Proposal Pack license covers installation on up to five computers to allow for this type of setup without having to purchase multiple Proposal Pack licenses.

Many Mac users also run both Windows and Mac operating systems on their Mac computers using a dual boot system and
software such as Parallels. You can run our Wizard in this environment on your Mac by running it within the Windows system. This setup means you only have to have one hardware platform (i.e. the Mac laptop or desktop computer), but you can run both Windows and Mac operating systems on it. This type of setup does require that you install the dual boot software, Microsoft Windows and Microsoft Office Professional or Home Premium on your Mac.
ANATOMY OF A PROPOSAL

Your proposal may be anywhere from one page long to hundreds of pages long depending on many factors. The average proposal is 10 to 15 pages in length. The diagrams on the following pages show the anatomy of a proposal containing many of the various types of proposal templates included in the Proposal Packs. Your specific proposal will use a subset of the full collection of templates. Specific examples of proposals based on the same diagram are also included below. You will find the actual sample proposals illustrated below in the Sample Proposal Collections, which are bundled with each Proposal Pack.

The first diagram shows the anatomy of a complete proposal including templates from all of the major categories (Introduction Pages, Client Pages, Project Pages, Your Company Pages and the Appendix Pages).

If you are also using the add-on Proposal Pack Wizard, the Recommend Wizard uses this same structure for creating the proposal frameworks. You can also manually open and edit all of these templates using your word processor.

If you look at the included Table of Contents template, all of the templates in the Proposal Pack are grouped in order to assist you in selecting which documents to use and what order to use them in. The Proposal Pack HTML organizer also lists all of the templates in the same consistent order. Note that these examples and default orderings of the proposal pages are only examples and suggestions. You may organize the proposal and use the templates in any order and combination you see fit.
These diagrams show that regardless of the industry or type of proposal being created a similar framework is used, usually starting with the basics of a Cover Letter, Title Page, Executive Summary and as many supporting templates as needed in each case. Make sure to review all of the included sample proposals which illustrate a wide variety of uses for the Proposal Packs. Also review the Proposal Writing Primer section of this manual for further details on the organization of a proposal.
Comprehensive collection of templates organized by category:

Introduction Pages
- Cover Letter
- Title Page
- Table of Contents
- Non-Disclosure

Client Pages
- Executive Summary
- (more body page chapters here)
- Opportunities

Project Pages
- Expected Results
- (more body page chapters here)
- Project Summary

Your Company Pages
- Mission Statement
- (more body page chapters here)
- Qualifications

Appendix Pages
- List of Illustrations
- (more body page chapters here)
- RFP Cross Reference
Micro (or Letter) Proposal Example:

The following diagram shows the anatomy of a micro project proposal using only 4 templates. This diagram is based on the sample included titled “Micro PowerPoint Project Proposal”. See the complete PDF version of the actual proposal in the included sample proposals.

This sample was created for pitching a PowerPoint development project. Since this was a small dollar amount project, most of the proposal was contained in a one page Executive Summary. A one page Cost Summary was included to show the costs of the project. A one page short form contract was included to spell out the terms of the agreement.

Introduction Pages

- Title Page

Client Pages

- Executive Summary
- Cost Summary

Project Pages

- Contract and Terms
Small Proposal Example:

The following diagram shows the anatomy of a small service proposal using nine templates. This diagram is based on the sample included titled “Accounting and Payroll Services Proposal”. See the complete PDF version of the actual proposal in the included sample proposals.

This sample was created for an accounting firm proposing its accounting and payroll services to a potential client. Since this was a more expensive project covering ongoing client services more templates were added. A one page Cost Summary was included to show the costs of the project including setup, monthly and yearly fees along with a custom contract and terms statement.

Introduction Pages

- Cover Letter
- Title Page
- Table of Contents

Client Pages

- Executive Summary
- Client Operations

Project Pages

- Cost Summary
- Contract and Terms
- Benefits
- Project Management
Medium Proposal Example:

The following diagram shows the anatomy of a medium project proposal using eighteen templates. This diagram is based on the sample included titled “CD-ROM Development Proposal”. See the complete PDF version of the actual proposal in the included sample proposals.

This sample was created for pitching a marketing CD-ROM development project. Since this was a more expensive project (over $10,000), many more templates were added. The additional templates were added to clearly show that the company making the proposal is a leader in their area of expertise and has the experience and portfolio that is a perfect fit for the client’s needs.

Introduction Pages

- Cover Letter
- Title Page
- Table of Contents

Client Pages

- Executive Summary

Project Pages

- Benefits
- Features
- Technical Approach
- Production Schedule
- Deliverables
- Cost Summary
- Project Management
- Training Plan
- Case Studies
PROPOSAL WRITING PRIMER

Writing a good proposal takes planning and preparation. Your proposal may be your only chance to sell yourself to a prospective client, so spend the time you need to present your history, your analysis of the needs to be met, and your solution in a polished, professional manner.

Depending on the complexity of the project under consideration, proposals may be as short as three pages of basic, straightforward information, or as long as one hundred pages filled with detailed research studies, projected results, and cost summaries. Proposal Pack includes templates for all the standard parts of a proposal.

Whether concise or complex, all proposals must include the following basic information:

- A discussion of the problem you are proposing to solve or the need you are proposing to meet.
- Your qualifications to undertake the project.
- A detailed description of what you propose to do to solve the problem or meet the need, including your proposed timetable and costs.
Some proposals, such as those submitted in response to a specific Request for Proposals (RFP), may need to meet strict guidelines spelled out by your prospective client.

In many cases, to receive an invitation to submit a proposal, you'll need to send an inquiry letter first. Inquiry letters should be printed on your company's letterhead and should contain:

- A brief summary of the problem or need.
- A summary of information about your organization and how it is qualified to solve the problem or meet the need.
- A request for permission to submit a full proposal.

With the inquiry letter, you may also need to include an executive summary, which summarizes the highlights of your proposal. Your following full proposal will spell out the details.

Use Proposal Pack's Inquiry.docx template for your inquiry letter, and, if needed, the ExecutiveSummary.docx template for your executive summary. You can read more about the executive summary in the following pages.
Here is a common order of documents in a proposal:

- Cover Letter (Introduction templates)
- Executive Summary (Client-centered templates)
- Cost Summary
- Needs Assessment Section
- Goals and Objectives Section (Project-centered templates)
- Methodology Section
- Evaluation Section
- Financial Section
- Project Summary Section
- Your Company Qualifications Section (Company-centered templates)
- Appendices (Appendix templates)

The following is a more detailed step-by-step discussion of how to put your proposal together using the Proposal Pack templates.

Proposal Pack includes a very large collection of templates to cover most of your needs. Your proposal could be one page long to hundreds of pages long depending on many factors. The average business proposal is 10 to 15 pages long. Use your best judgment to determine which templates are suitable for your specific proposal.

Start with a Cover Letter, Executive Summary and Cost Summary then continue adding pages as they relate to your client, project and proposal.
Cover Letter

Introduce yourself and your purpose. Like any good business letter, cover letters are typically printed on company letterhead.

Use the CoverLetter.docx template for your cover letter.

Executive Summary

Present the highlights of your proposal and how it will benefit this prospective client, then concisely state your qualifications for accomplishing this project. The executive summary is frequently the most often read section of a proposal: take the time to hone it to professional perfection.

Use the ExecutiveSummary.docx template for your executive summary.

Cost Summary

Sum up the costs for your proposal. If you’re considering a complex project, list only broad categories here; save the details for later in the financial section.

Use the CostSummary.docx template for your cost summary.

Needs Assessment Section (Problem Statement)

Explain the problem or need you propose to address and then detail how you performed your analysis and reached your proposed solution. You may want to include statements about business opportunities, comparisons with competitors or a general discussion of the industry, or discussions of marketing or operations issues.
Choose from the Opportunities.docx, Competitive.docx, Industry.docx, Background.docx, Operations.docx and Market.docx templates as needed for this section.

Goals and Objectives Section

This section describes the results you plan to accomplish, and provides explanations of how your success will be measured. For example, you may want to discuss how a process will be streamlined, how sales will increase, or how customers will be more satisfied.

Use the Results.docx, Statement.docx, Benefits.docx, Features.docx, Samples.docx, Deliverables.docx, and Services.docx templates as needed to flesh out the goals and objectives section of your proposal.

Methodology Section

Here is where you get down to all the details. Describe the process you will use to carry out your proposal, making sure to address all parts of your plan. Include discussions of personnel and equipment needed, the project schedule and milestones, the constraints and assumptions you're working with, and any other information your client needs to understand precisely what you propose to do.

Evaluation Section

Explain how the success of your solution will be concretely measured, by whom, and when these tests will be performed. For a complex project, you may need to include milestones along the way.

Use the Requirements.docx, Documentation.docx, Interface.docx and Accept.docx templates as needed to cover the evaluation sections of the proposal.

Financial Section

In the previous Cost Summary, you listed the total cost of your proposal, and perhaps the major cost categories as well. In this section, present the details that demonstrate how you arrived at your total cost. Be sure to include all items the prospective client will pay for, as well as any discussion needed to show how you arrived at the budget figures listed.

Use the CostBenefit.docx, SuppliedMaterial.docx, Equipment.docx, HardSoft.docx, Payment.docx, Contract.docx, WorkOrder.docx, WorkOrder2.docx templates as needed to cover the financial section of the proposal.

Project Summary Section

Here's your final chance to sell your proposal again. Concisely describe the problem to be tackled, and then sum up the highlights of your proposed solution, and how your proposal will meet the client's needs.

Use the Summary.docx and Recommend.docx templates for your project summary.
Your Company Qualifications Section

What makes you qualified to take on this project? Describe your history, other similar and successful projects, and other clients as needed to show that you are the perfect choice to get the job done.

Proposal Pack includes many templates for your qualifications, including but not limited to: MissionStatement.docx, Qualifications.docx, QualityControl.docx, CaseStudy.docx, CompanyHistory.docx, Products.docx, Future.docx, ExecBio.docx, Testimonial.docx, References.docx, Portfolio.docx, Resume.docx.

Appendices

Attach any details you need to complete your proposal. These might include legal papers for your company, lists of personnel, financial statements, testimonials, charts, blueprints—anything you require to provide all the information your client needs to make a decision.

There are many templates to use for your appendices, including but not limited to: Illustrations.docx, Acronyms.docx, Benchmark.docx, RefMaterial.docx, Financial.docx, CrossRef.docx, Disclaimers.docx and Warranty.docx.
HOW TO SELECT TEMPLATES: THE TOP 5 / TOP 40 RULE

There are over a thousand document templates to choose from. Because any type of proposal, business plan, study, etc. for any industry, any business situation, and any size of document can be written with a Proposal Pack, we need a large collection of templates to cover everyone.

The trick is then to figure out what small set of templates are best suited for your situation and efficiently find them.

Technically, using Proposal Pack is very easy. It is nothing more than opening some documents and typing in your word processor. The hard part is wrapping your head around the large amount of material and deciding what parts to use.

A very short proposal may be 1-3 pages long for a short form quote or bid, an average size proposal may be 10-15 pages long, a government grant could be 30-80 pages long.

Start by looking at the large collection of Sample Proposals. There are many samples which you can use to get ideas from. Sample Proposals will show you how other people selected templates, assembled them together in a specific order and filled them out. They will give you ideas on what templates you might want to select. Samples Proposals are the PDF documents included with the large collection of editable templates.
Then consider using these Top 5 most commonly used templates first:

- Cover Letter
- Title Page
- Table of Contents
- Executive Summary
- Cost Summary

Then consider templates from the Top 40 most commonly used list:

- Non-Disclosure Form (Short Version)
- Introduction
- Estimate
- Needs Assessment
- Opportunities
- Market and Audience
- Goals and Objectives
- What You Can Expect
- Statement of Work
- Expected Results
- Benefits
- Features
- Project Deliverables
- Evaluation
- Acceptance Criteria
- Budget
- Cost/Benefit Analysis
- Work Order (Without Deposit)
- Work Order (With Deposit)
- Hourly Services Contract
- Invoice
- Payment Schedule
Finally, start looking through the rest of the entire collection of thousands of templates to find specialty templates that will fit your situation. You can find the entire list in the What is Included? chapter and in the Proposal Pack desktop HTML organizer.

You can search for specific templates by name using the search feature of this PDF manual, by using the search feature of your web browser when you are viewing the complete list of templates in the Desktop organizer, or by using your operating system Search feature to search for text across all of the templates installed on your hard drive.
FREQUENTLY ASKED QUESTIONS

Q: How do I insert my own logo?

A: If you are inserting a new graphic into a document first click the “Insert > From File” menu option and pick your new graphic. We recommend using at least a 120 dpi PNG format graphic. Try to avoid compressed JPG or GIF files as they might not print high quality. To position your logo, select the “Text Wrapping” option on the Picture toolbar when your logo is highlighted (after inserting it). Then select the “in front of text” option. You can then freely move your logo around the document (refer to your specific word processor for exact details).

If you want to add your logo to the graphics, then you must first edit the graphics in a program such as Photoshop or Illustrator. Then save your edited graphics as a 120 dpi (or even higher resolution) PNG file. Then follow the instructions above to import your updated graphics back into the documents.

Q: Where are the files on my computer?

A: When first installing the Proposal Pack, you were prompted to choose a location for installation and all associated files. This is where files are located. All templates and graphics are contained on your hard drive in the original folder you chose. The default install folder is:

“C:\ProposalKit\ProposalPack\[the style of pack]”
**Q: Where do I start?**

**A:** First review all of the material to get an idea of what is included. Then review this documentation, the organizer and the tutorial. Review the sample proposals to see how the final proposals were created using the Proposal Pack templates. Then pick a subset of the full collection of Proposal Pack templates and start filling them out for your particular proposal. See the “Getting Started” section in the web page organizer “Open Proposal Pack Materials” which is located on your desktop. While there are many templates to choose from, your final proposal can be as short as 3 pages long. Start with the basics such as a Cover Letter, Title Page, Executive Summary and Cost Summary. Then add more templates as needed for your situation.

**Q: How do I edit the text in the page headers?**

**A:** The page header title text cannot be edited unless you are using “Proposal Pack for Any Business” or “Proposal Pack for Government Grants”. If you try to click the page headers the entire box will be selected. Each page header is a graphic PNG file imported into the template. You must use your graphics program to edit the page header titles. Once edited and saved, delete the existing page header graphic in the template and import the new one in the same location. See the web page organizer for links to all of the stock graphics included with each Proposal Pack. Also see the section in this manual titled [Easily Create Your Own Graphic Style](#).
Q: Why are all of the templates in separate files?

A: Since there are a virtually unlimited number of combinations of templates for any given proposal the templates are best left in individual files. If all of the templates were imported into a single file you would spend more time deleting irrelevant sections rather than picking a small collection of separate template files.

Using separate templates also allows you to have multiple people working on sections of the proposal. Future proposals can also be easily put together using individual template files from existing proposals. Also, different types of proposals have different arrangements in the ordering of the templates.

About the only drawback to separate templates is that page numbering and creating of a table of contents requires a little more manual work. Another reason is to allow a team of people to edit specific pages of a proposal which is combined as the parts are completed.
REQUIREMENTS FOR USE

Required

A word processor which can read Word formatted documents such as Microsoft Word, Pages, iWork, OpenOffice, StarOffice, Word Perfect, Google Docs or Appleworks).

Windows, Mac or Linux operating system.

A web browser.

Adobe Acrobat Reader (or compatible program).

Optional

Proposal Pack Wizard automation software can be used to automate some of the tedious tasks of managing your proposal development. Proposal Pack Wizard works with all of our Proposal Pack template collections. See this page for details: https://www.proposalkit.com/htm/proposal-writing-software.htm

Proposal Kit Professional is a separate product including costing/estimate spreadsheets, diagrams, design tools and a full suite of contract and agreement templates for web and IT professionals.

Adobe Illustrator for editing .EPS files, Adobe Photoshop for editing .PSD files or any other graphics program for use with .PNG and/or .JPG graphics.
Font files are required for editing exact fonts in .EPS and .PSD files. If you do not have these fonts you can purchase them from Adobe or any number of font web sites or use a different font when editing the graphics files if you do not already have those fonts on your system.

Adobe Acrobat may optionally be used to save your final proposal as a distributable PDF document. Some word processors also include a built-in PDF export option. This will help protect your files from modification and make them easy to distribute electronically across multiple platforms.
HOW DO I USE IT?

Proposal Pack is a set of templates designed to save you time and money. A small proposal of just a few pages can be created in as much time as it takes for you to gather some basic information about your company, your client and the proposed project and paste it into a few of the templates. The larger and more complex the proposal the longer it will take to create. Most of the work will be in the gathering of the content specific to your company, client and project.

- Edit the graphics to further customize the templates (optional)
- Open each needed document in your word processor
- Merge your data to replace the common tags (name, address, etc.)
- Replace any other tags in the templates with your own information
- Save, package and distribute your proposal

Since each Proposal Pack is a set of editable documents, all the work is done in your own word processor. There is no “application software” included in the Proposal Packs however we do have an optional add-on software program Proposal Pack Wizard. Each Proposal Pack contains a different style (artsy, techie, industrial, etc.). There are many available and many more to come.

If you want to create a quick proposal and don’t plan to set up mail merge automation, type over the tags using your own information.

You can change the graphics in the templates by first editing the original artwork files to create new graphics. If you want to edit the supplied original artwork files in Illustrator or Photoshop, you may need to purchase additional fonts from Adobe. Save your
variations as PNG files. Then delete the old graphic from the
document, and import a new one from the “Insert > Picture > From
File” menu in your word processor. If you are planning to distribute
the document, you should not import original EPS or PSD files,
since other users may not have the proper conversion plug-ins,
fonts, etc.

Distribute your final proposal in printed form on paper, saved as a
single Acrobat PDF document or as a web page for on-line
distribution. We do not supply distribution tools. To create PDF
versions of your documents, you will need to purchase Adobe
Acrobat.

To insert your own logos and graphics, locate the position with
your cursor in your word processor then click the Insert > From File
option in Word, pick your graphic and then adjust using Words
graphic editing toolbar as needed. We recommend saving your
graphics in 120 dpi (or higher resolution) PNG format files.
Importing web site graphics in .GIF/.JPG format can result in
graphics that do not print high quality. Refer to your word
processor manual for specific details on importing graphics.

An additional tutorial is located at:
HOW DO I INSERT MY OWN LOGO?

Proposal Pack is a collection of editable documents that you edit using your own word processor. Every word processor is different, however, inserting your logo into a document is a common task that all word processors can do.

If you are unfamiliar with how to insert a picture or a graphic into a document consult your word processors help instructions.

For example, using Microsoft Word, you would open one of your Proposal Pack documents, then click the Word toolbar option “Insert”, then click “Picture” then browse your hard drive to locate your company logo graphic and then click the Okay button to insert it into your document.

Once you insert your logo, use your word processor’s picture formatting properties to resize the logo and position it in the appropriate location of the document.

Using Microsoft Word as an example, right-click your mouse button over your inserted logo to get to the picture formatting options. By changing the picture layout to “in front” or “behind” text will allow you to fine tune the exact positioning of your logo within the document. Other options will wrap text around the logo. Use your word processors picture formatting features as best fits your needs.
HOW DO I CREATE CUSTOM BULLET POINTS?

This feature is not supported by all Word processors. Consult your particular word processor documentation to see if you can use custom graphics as your documents bullet points. This chapter is written based on using Microsoft Word.

Your word processor offers a variety of bullet point styles. By default bullet points are small solid circles. Other common options are open circles, squares, diamonds, etc. Your word processor may also offer custom graphics as bullet points with a variety of choices built in.

Many Proposal Pack logo design themes also include custom graphic bullet points that match the custom logo that comes with each theme.

You will see this use of custom graphics used in many of the Acrobat PDF sample proposals. The bullet points using the Proposal Pack logo in this page below make use of the same feature.

Since custom graphics used as bullet points are a feature not supported by all word processors we do not ship our templates with the custom bullet point graphics in use. To see custom bullets in use open this document:

c:\ProposalKit\ProposalPack\{style_name}\Documents\Word\WatermarkExample.docx
You can use Microsoft Word to change your documents default bullet points to use the custom bullet point graphics by doing the following:

1. First, highlight the bullet point with your mouse so it is selected by clicking the right mouse button when your mouse is over the bullet point.

2. Mouse over the “Bullets” menu and click the “Define New Bullet” option.

3. Click the “Picture” button, then click the “Import” button.

4. Browse to the location of the custom bullet graphic. You can use your own graphic image or the custom one created for your Proposal Pack. To locate the one for your Proposal Pack, browse to the file: `c:\ProposalKit\ProposalPack\[style_name]\Graphics\PNG_Graphics\Bullet.png`

5. Click okay, then select that graphic from the list of available bullets.

6. Your documents bullet points will now be changed to the new graphic.

7. Repeat for all of the bullet point lists used in your document.
HOW DO I ADD A TITLE PAGE BACKGROUND GRAPHIC?

This feature is not supported by all Word processors. Consult your particular word processor documentation to see if you can use a custom background graphic in your documents that sits behind all of the other elements. This chapter is written based on using Microsoft Word.

Background graphics are supported on other platforms including Pages for the iPad. How the background graphics are supported is platform dependent. Consult your word processor documentation for help.

Microsoft Word has a feature called a “watermark”. You can add a watermark by clicking the Word menu Page Layout > Watermark > Custom Watermark. Then click the “Picture Watermark” option and browse to the custom watermark graphic.

Many Proposal Pack design themes include a custom watermark graphic for use in the Title Page. This custom watermark typically covers the entire 8.5x11 portion of the Title Page background and is designed for your title page text and graphic logos to sit on top of. All of the elements of the title page combine to create a professionally designed visual look.

You can also create your own title page backgrounds using any graphics editor program. Create your graphic as a 120 to 300 pixel/inch resolution image that is 8.5 x 11 inches in size (or whatever your standard page size is for international page sizes). Save your graphic as a PNG file and it is ready to import.
If your Proposal Pack was designed with a custom watermark title page graphic you will find them in the folder:

c:\ProposalKit\ProposalPack\[style_name]\Graphics\PNG_Graphics\Backgrounds

Since background watermarks do not work in all word processors Proposal Pack includes two different title pages:

**TitlePage.docx** - This is the general purpose title page with a plain white canvas. This version will work in all word processors.

**TitlePage2.docx** - This is the version that works with Microsoft Word and any other word processor that supports watermark graphics.

Using watermark backgrounds in your proposal’s Title Page requires some extra work to setup your proposal document correctly due to how Microsoft Word works. These instructions are entirely about how Microsoft Word works and is not a limitation or feature designed specifically by Proposal Pack. Proposal Pack uses the existing Microsoft Word watermark feature. Consult your Microsoft Word documentation for more details on how to use watermarks.

First, watermarks are tied to Microsoft Word’s page headers. Page headers by default are replicated across every page of your document. Because of this, when you add a watermark or start your proposal with a document such as TitlePage2.docx that includes a watermark that background will be added to every page of your proposal.
Because the Title Page watermark is only supposed to be used on the Title Page you need to isolate the Title Page from the rest of your document. Do this by switching to Draft view and inserting a “Section Break” instead of a “Page Break” after the end of the Title Page. Then switch back to Print Layout view, click the header area of the page after the Title Page and in the Header and Footer tools menu unlink the 2nd page’s header from the Title Page above.

What you have done now is isolate the document into 2 “sections”. The first section is the Title Page (and anything above it) and the second section is the rest of your document (all of the body pages such as your Table of Contents, Executive Summary and so on). If you have any pages above the Title Page (such as a cover letter) you need to repeat this process to isolate the pages above the Title Page into another section.

Now you will only see the Title Page background watermark in the Title Page. If you see the background watermark in any other pages or sections you can double click the header of a page in that section, click on the watermark graphic and delete it.

If you need further instructions consult your Microsoft Word document for “watermarks” and “sections”.

Another issue to deal with when breaking your proposal document into multiple sections is how page numbers are added to your document. It can take some work to get all the starting page numbers and locations where you want them.
If using sections is too complicated, an alternative is to keep your Cover Letter and Title Page in separate documents so you don’t have to deal with as many layout issues. Then create the body of the rest of your proposal in another document. Then when converting your document to PDF format, combine the separate PDF files together into a single document when all the pieces are complete.

If you are creating a multi-page document that includes a cover letter, custom Title Page (that uses a background watermark) and you want to use the faded background watermark graphic in the body of your proposal consider breaking your proposal into multiple documents.

This is because Microsoft Word is not a layout and design program, it is a word processor – that has some layout and design capabilities. It can be an exercise in frustration getting all of these elements including page numbers to all cooperate together in a single document unless you are an expert in the use of Microsoft Word’s features.

It can be more efficient to save your Cover Letter as one document. This is typically a plain text template with no logos or graphics. You may or may not print this on your own company letterhead.

Then create your custom Title Page in a 2nd document. This document will include the custom Title Page watermark background.
Then create the body of your proposal (all of the topic pages such as your Table of Contents, Executive Summary, Products, Services Provided, Company History, and so on) in a 3rd document. This document is where you can insert the page numbers and a background faded watermark graphic.

When you are done editing these three files as Word documents save them as PDF files.

The last step is to combine the PDF files into a single PDF document. This is accomplished by using Adobe Acrobat or any number of 3rd party tools.

If you do not have the full retail version of Adobe Acrobat search online for “how to combine PDF files”. There are many free or lower cost solutions than Adobe Acrobat available.

Combining the files after they have been saved as PDF files solves the design and layout problems that would occur if you tried to combine all of these within Microsoft Word from the beginning.

**Using both a Title Page background AND a body background together:**

Since the background watermark feature is used to insert both your Title Page custom background and your custom body background watermark this can cause a problem when you use Word’s Page Layout option to insert a new watermark.
This is because Word will completely replace the background in every page of your document regardless of how you sectioned off the Cover Letter and Title Page. The trick is to no use the Page Layout > Watermark option more than once per document in this situation.

Instead, click into the header section of the body of your document and use the Insert > Picture option or copy and paste the body watermark out of the WatermarkExample.docx file. This will preserve the Title Page watermark you added to the Title Page.
HOW DO I ADD A WATERMARK BACKGROUND GRAPHIC?

This feature is not supported by all Word processors. Consult your particular word processor documentation to see if you can use a custom background graphic in your documents that sits behind all of the other elements. This chapter is written based on using Microsoft Word.

Background graphics are supported on other platforms including Pages for the iPad. How the background graphics are supported is platform dependent. Consult your word processor documentation for help.

Microsoft Word has a feature called a “watermark”. You can add a watermark by clicking the Word menu Page Layout > Watermark > Custom Watermark. Then click the “Picture Watermark” option and browse to the custom watermark graphic.

Many Proposal Pack design themes include a custom watermark graphic for use in the body of your document which is a transparent background image used as an design accent that is replicated identically across every page of the proposal. This custom is designed for your document’s text and graphic logos to sit on top of. All of the elements of the design combine to create a professionally designed visual look.

You can also create your own backgrounds using any graphics editor program. Create your graphic as a 150 to 300 pixel/inch resolution image that is about 5 or inches in size. Save your graphic as a PNG file and it is ready to import.
If your Proposal Pack was designed with a custom watermark background graphic you will find them in the folder:

c:\ProposalKit\ProposalPack\[style_name]\Graphics\PNG_Graphics\Backgrounds

Since background watermarks do not work in all word processors Proposal Pack only includes this background in an example document:

**WatermarkExample.docx** - This document is in your Proposal Pack’s documents folder. It has the custom body watermark added to it so you can see how it is used in a document.

Note that this works exactly the same as the Title Page watermark and it is how you setup your document sections that replicate it across your entire proposal.

Using watermark backgrounds in your document requires some extra work to setup your proposal document correctly due to how Microsoft Word works. These instructions are entirely about how Microsoft Word works and is not a limitation or feature designed specifically by Proposal Pack. Proposal Pack uses the existing Microsoft Word watermark feature. Consult your Microsoft Word documentation for more details on how to use watermarks.

First, watermarks are tied to Microsoft Word’s page headers. Page headers by default are replicated across every page of your document. Because of this, when you add a watermark that background will be added to every page of your proposal.
Because the body watermark is only supposed to be used on the body pages of your proposal (i.e. not your Cover Letter or Title Page) you need to isolate the body pages of your document from the first pages of your document (i.e. the Cover Letter and Title Page). Do this by switching to Draft view and inserting a “Section Break” instead of a “Page Break” after the end of the Title Page. Then switch back to Print Layout view, click the header area of the page after the Title Page and in the Header and Footer tools menu unlink the 2nd page’s header from the Title Page above.

What you have done now is isolate the document into 2 “sections”. The first section is the Title Page (and anything above it) and the second section is the rest of your document (all of the body pages such as your Table of Contents, Executive Summary and so on).

Now you will only see the background watermark in the body pages. If you see the background watermark in any other pages or sections you can double click the header of a page in that section, click on the watermark graphic and delete it. Sometimes when you break your document into sections and insert a body watermark it may show up in another section which will need to be deleted.

If you need further instructions consult your Microsoft Word document for “watermarks” and “sections”.

Another issue to deal with when breaking your proposal document into multiple sections is how page numbers are added to your document. It can take some work to get all the starting page numbers and locations where you want them.
If using sections is too complicated, an alternative is to keep your Cover Letter and Title Page in separate documents so you don’t have to deal with as many layout issues. Then create the body of the rest of your proposal in another document. Then when converting your document to PDF format, combine the separate PDF files together into a single document when all the pieces are complete.
HOW DO I USE THE CALCULATOR SPREADSHEETS?

Proposal Pack includes a large number of calculator spreadsheets. For each Word template that includes financial information there is a corresponding calculator spreadsheet.

For example, the Estimate.docx file is used with the EstimateCalculator.xlsx spreadsheet, the CostSummary.docx file is used with the CostSummaryCalculator.xlsx spreadsheet and so on.

The .docx Word documents and the .xlsx spreadsheets are not connected to each other initially. For example, if you update the calculations in a spreadsheet, they are not automatically populated in any documents.

When used in conjunction with the Proposal Pack Wizard software the Wizard software can add dynamic OLE links between the spreadsheet cells and your assembled Word documents. You can also manually link spreadsheet cells into your Word document using Word and Excel’s built in dynamic linking features.

The spreadsheets are intended to be used as tools to help you perform more complex calculations than you would completely show in the final delivered proposal. Use the spreadsheets to make your calculations then manually type the totals into the Word documents. The spreadsheets are not intended to be distributed with your final proposal. Typically you only want to show the highlights of the financial details and not all of the underlying calculations.
You can easily locate the matching spreadsheet for a template by opening the Proposal Pack desktop organizer, navigate to the organizer page for the template that has a corresponding spreadsheet, then click the link to launch the spreadsheet. The spreadsheets are also named in a way that matches the name of the corresponding template making it easy to locate by browsing to the Spreadsheets folder on your hard drive.

The Proposal Pack Wizard add-on software utility will also make a copy of any corresponding spreadsheets for any templates you have selected for your current project. Each of your projects will have a copy of the spreadsheets in your project folder ready to edit for that project.

There are a number of reasons there are no direct connections between the spreadsheets and word documents such as: Links are easily broken when people install, copy and move their files around, links may not be supported on all platforms and word processors that the Proposal Packs are used on, and not everyone has both the word processor and spreadsheet software that can make use of crosslinking.

As you design your own personal workflow you may add connections between spreadsheets and Proposal Pack templates using standard office software features however you are responsible for maintaining your customized system.
HOW DO I EDIT THE SAMPLES?

The Proposal Pack’s completed samples are Adobe Acrobat PDF documents. If you are not familiar with what a PDF file is, it is a standard file format that ensures your file will be displayed on other people’s computers as you intended it to be displayed. A PDF file is also a non-editable file (i.e. it is for viewing only, not for editing). This means the sample proposals cannot be edited.

You use the Proposal Pack’s editable Word documents to write your own custom proposal, business plan, study, or other business document tailored to your specific needs.

Each completed sample that is in Acrobat PDF format also includes editable plain text versions of every page of the sample. The plain text sample pages in Word format are contained in the “Pages” subfolder of each sample. While you can use these editable text pages to copy and paste text if it makes it easier for you to reuse sample content these pages are intended for use by the Proposal Pack Wizard software. If using the Proposal Pack Wizard software the Wizard has the ability to automatically import the sample content into the document being generated and will apply the visual design theme being used to the sample content as well as merge your contact information making it more efficient to create a customized version of any sample.

Samples are included as guides to help show you how a final document can look, how someone else selected a collection of templates and filled them in for more specific situations.
Since business proposals, business plans and other documents are all unique and specific to the person doing the writing, the person it is being written for, the industry the writer is in and the project, product, service, etc. that is being written about. It is very unlikely you will find a sample anywhere that exactly matches your situation that you can make some edits to if your document is of any complexity.

You can however get ideas on how to go about writing your own content using the large collection of samples and editable templates.

Make sure to read the chapter Stay Out of Trouble Copying Proposal Examples to ensure you do not make any of the mistakes that can commonly occur when copying content that you have not written yourself into your proposal.

Proposal Packs are designed using proposal writing best practices, and one of those practices is to write your own content ensuring your document is consistent in theme, content and writing style.
WHAT ARE MAIL MERGE AND TAGS?

The Proposal Pack documents are plain text documents with common information in plain text tags such as <<FirstName>>, <<Company>>, etc.

This means that there are tags in the documents such as <<FirstName>> which are replaced with your own personalized information.

Only tags enclosed in <<>> brackets are intended to be replaced with data. Some contracts and agreements include text such as “Company”, which is not a mail merge tag and is intended to be left as-is.

Automating the process using the mail merge feature will help keep common information consistent across multiple documents. Every word processor has a proprietary mail merge system which may or may not be compatible with other systems. Proposal Pack templates use plain text tags which will be viewable and editable in any word processor. You can convert our tags to proprietary tags yourself and tie them to a database, your email address book, contact manager, etc. Consult your word processor help for setting up a database for mail merge.
The number of tags in our documents is minimal, so manually replacing them is quick and easy. Just search the document for any occurrence of “<<” to find the tags and replace them. You can either replace the tags by applying a merge data file manually type over them. There is no need to learn complex software. If you use our add-on Proposal Pack Wizard software the wizard will automatically update all of your documents in a single operation.

There are two types of tags in the Proposal Pack documents.

**Data tags** - these are common tags for contact information.

For example, <<Domain>>, <<FirstName>>, <<Company>>.

**Standard text tags** - these are easily replaced by manually over-typing. Using the example of, << Insert company history here >>, this type of tag will be replaced with details about your company. This can be done as easily as cutting and pasting it from other existing collateral material. Such tags are generally meant to be free form text specific to your situation (company, client, project, contract, etc.). You replace these types of instructional tags yourself.
The following is a list of the mail merge tags used in Proposal Packs and Proposal Kit documents:

YOUR COMPANY’S TAGS

- **<<Salutation>>** Your title (Mr., Mrs.)
- **<<FirstName>>** Your first name
- **<<LastName>>** Your last name
- **<<JobTitle>>** Your job title (President, Project Manager)
- **<<Company>>** Your company name
- **<<Address1>>** Your address
- **<<Address2>>** Your address
- **<<Address3>>** Your address
- **<<City>>** Your city
- **<<State>>** Your state
- **<<PostalCode>>** Your zip or postal code
- **<<Country>>** Your country
- **<<County>>** Your county
- **<<Fax>>** Your fax number
- **<<WorkPhone>>** Your work phone
- **<<MobilePhone>>** Your mobile phone
- **<<Email>>** Your e-mail address
- **<<Domain>>** Your website URL
YOUR CUSTOMER’S TAGS

- <<CustTitle>>: Customer job title (President, Project Manager)
- <<CustFirst>>: Customer first name
- <<CustLastName>>: Customer last name
- <<CustDomain>>: Customer domain (new or existing URL)
- <<CustCompany>>: Customer company name
- <<CustAddress1>>: Customer address
- <<CustAddress2>>: Customer address
- <<CustAddress3>>: Customer address
- <<CustCity>>: Customer city
- <<CustState>>: Customer state
- <<CustPostalCode>>: Customer zip or postal code
- <<CustCountry>>: Customer country
- <<CustCounty>>: Customer county
- <<CustFax>>: Customer fax
- <<CustWorkPhone>>: Customer phone
- <<CustMobilePhone>>: Customer mobile phone
- <<CustEmail>>: Customer e-mail
- <<CustSalutation>>: Customer title (Mr., Mrs.)
- <<ProposalNumber>>: The unique identifier for each proposal you send
- <<ProposalTitle>>: The title of this proposal
- <<CurrentDate>>: Date the proposal was created
CONTRACT RELATED TAGS

- <<HourlyRate>> Your hourly service billing rate
- <<FixedRate>> Your fixed billing rate
- <<HostCompany>> Company hosting client’s website
- <<HostSetupFee>> Setup fee for website host account
- <<HostMonthlyFee>> Monthly ISP charges
- <<DomainRegFee>> Domain registration fee
- <<RegisteredWith>> Company URL registered with
- <<YearlyDomainFee>> Yearly fee for domain name
- <<Reference>> Unique contract reference number
- <<WorkOrder>> Contract or work order unique identifier code
- <<StartDate>> Contract start date
- <<EndDate>> Contract end date
- <<CurrentYear>> Current year
- <<CurrentDay>> Current day
- <<CurrentMonth>> Current month
- <<DeliveryDate>> Date contract is to be delivered by
- <<ContractCompany>> Company name on the contract document
- <<ContractFirstName>> First name of person on the contract document
- <<ContractLastName>> Last name of person on the contract document
- <<ContractJobTitle>> Job title of person on the contract document
- <<InsuranceCoverageAmount>> Amount of insurance coverage
- <<Credits>> Photographers or authors credits
- <<SSN>> Social Security Number
- <<Approver>> Person authorized to make approvals
- <<Supervisor>> Employee or contractor supervisor name
- <<Department>> Employee or contractor company department
- <<Month>> A month as applies in the context of the used clause
- <<Amount>> A dollar amount as applies in the context of the clause
- <<HREmail>> Email address of the Human Resources department
- <<HRPhone>> Phone number of the Human Resources department
- <<HRContactName>> Persons name in the Human Resources department
<table>
<thead>
<tr>
<th>Identifier</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;&lt;TimeZone&gt;&gt;</td>
<td>Time zone that the contract applies to</td>
</tr>
<tr>
<td>&lt;&lt;Date&gt;&gt;</td>
<td>A date as applies in the context of the used clause</td>
</tr>
<tr>
<td>&lt;&lt;Minutes&gt;&gt;</td>
<td>A time in minutes</td>
</tr>
<tr>
<td>&lt;&lt;Hours&gt;&gt;</td>
<td>A time in hours</td>
</tr>
<tr>
<td>&lt;&lt;Days&gt;&gt;</td>
<td>A time in days</td>
</tr>
<tr>
<td>&lt;&lt;Months&gt;&gt;</td>
<td>A time in months</td>
</tr>
<tr>
<td>&lt;&lt;Years&gt;&gt;</td>
<td>A time in years</td>
</tr>
<tr>
<td>&lt;&lt;Weeks&gt;&gt;</td>
<td>A time in weeks</td>
</tr>
<tr>
<td>&lt;&lt;EffectiveDate&gt;&gt;</td>
<td>Effective date that an agreement is entered into</td>
</tr>
</tbody>
</table>
CUSTOM DEFINED TAGS

- <<Custom1>>  Reserved for any use
- <<Custom2>>  Reserved for any use
- <<Custom3>>  Reserved for any use
- <<Custom4>>  Reserved for any use
- <<Custom5>>  Reserved for any use
- <<Custom6>>  Reserved for any use
- <<Custom7>>  Reserved for any use
- <<Custom8>>  Reserved for any use
- <<Custom9>>  Reserved for any use
- <<Custom10>> Reserved for any use
- ...
- <<Custom50>> Reserved for any use

You can alter the labels and tags for the 50 custom fields from the Project screen. For example, you can change the default <<Custom1>> to <<WorkOrderNumber>>. Then, type the text <<WorkOrderNumber>> into the document. Then, in your Project data enter a number (12345 for example) in the data field for your custom merge information. When you run the configuration operation, your data (12345) will replace the merge tag <<WorkOrderNumber>>.
I WASN’T TOLD WHAT TO WRITE, WHERE DO I START?

A lot of our Proposal Pack users were put into the situation of being told to submit a proposal without being given any guidelines of what they should write. If this is the situation you are in, you are not alone. It happens to many people and it is one of the reasons Proposal Pack was designed the way it is.

Using Proposal Pack you can get access to any topics you need to discuss in a proposal and you can assemble those topics quickly into a master document, and then you can look at our large collection of sample proposals to get ideas on how to write your content.

If you do not have any idea where to start, first think about this. Most proposals are accepted because the person who accepted the proposal trusted the person who wrote it. Entire books are written on the various aspects of proposal writing, however, we are going to boil it down to the essence for those of you who are in a hurry. It’s all about trust. Read the following chapter for more details:

It’s All About Trust – Winning Proposals by First Winning Trust

Generally a proposal starts with an introduction, so first select the Cover Letter template.

Then select templates that show you understand the other party’s needs and situation. There are templates for Needs Assessment, Goals and Objectives and many others to pick from.
Then select templates that discuss your services, products, project, funding requirements, etc. Most of the Proposal Pack templates cover these types of topics such as Services Provided, Products, Project Background, Cost Summary, etc.

Then select templates that show how you can be trusted to deliver. Consider topics such as your Company History, Capabilities, Warranty, References, Testimonials, Letters of Support, etc.

As you select your templates, keep in mind you are trying to generate trust with someone who probably does not know you. Review the sample proposals for writing ideas as you select your templates. As you have time, continue reading and studying proposal writing topics to continue improving your proposals.
HOW TO WRITE A ONE PAGE PROPOSAL

Typically a proposal needs to include enough information to convince the person reading it to accept your proposal. Once you start having to write about your prospective client’s needs and your capabilities and everything in-between, proposals start growing in size. That’s why most proposals are between 5 and 15 pages long.

Even a very basic proposal that includes a Cover Letter, Services, Estimate and Company History becomes 4 pages long.

In cases where you know you already have the job, or you are not bidding against other companies and all you need to do is show the client how much a job will cost and getting their signature on it, a one page proposal is sometimes the answer.

This is easy with Proposal Pack as we include multiple documents that can stand alone as one page proposals or work orders.

The one page proposal is typically a short proposal and contract all rolled into a single page document.

Common uses would be for contractors doing a small project for a client.
These are the most common short form proposal/contract documents included in your Proposal Pack:

- Work Order (Without Deposit)       WorkOrder.docx
- Work Order (With Deposit)          WorkOrder2.docx
- Hourly Services Contract           HourlyServicesContract.docx

You can find these one page proposal/contract documents by using the Proposal Pack desktop organizer or by locating the document file names in the install folder where all of the Proposal Pack documents are located.
HOW TO WRITE A SERVICES SALES PROPOSAL

The majority of business proposals are about selling services, or a combination of products and services. Odds are that you have a lot of competition, so you need to craft a proposal that makes your organization stand out from the pack.

Proposal Pack has thousands of templates you can use to describe your organization, your services and your process. Explore the long list of templates included: just by perusing the names in the template list, you’ll recognize opportunities to provide all kinds of information to prove your case. A few templates designed specifically for selling services are Services Provided, Additional Services and Services Cost Summary.

See our online article How to Write a Service Sales Proposal for more details.

There are many different types of services offered out there, so we’ve provided a wide variety of sample proposals to show you how a sales pitch might be organized.
HOW TO WRITE A PRODUCT SALES PROPOSAL

Whether you are selling your products wholesale to a dealer or marketing to a specific retail customer, you need to put together a sales proposal that showcases your products and explains how working with you will benefit the customer.

Proposal Pack includes thousands of pages you can use to describe everything you have to offer. For example, you might want to include the following templates: Products, Product Visuals, Packaging, Shipping, Handling, and Product Cost Summary, just to name a few.

See our online article How to Write a Product Sales Proposal for more details.

We’ve also included sample proposals you can explore for ideas on how to structure your proposal.
HOW TO WRITE A QUOTE, BID, OR SHORT CONTRACT

If you are in a service business, odds are that you need to write a lot of quotes, bids, or short contracts. These are concise documents—usually one to three pages—that describe the work to be done, the cost of the work, and any guarantees, promises or dependencies.

The Proposal Pack templates that are most used for these types of documents are Cover Letter, Work Order, Hourly Services, Price List, Cost Summary, Invoice, and Guarantee.

See our online article How to Write a Quote, Bid or Short Contract for more details.

Proposal Pack includes many examples of these types of documents.
HOW TO WRITE A PROPOSAL FOR A PROJECT

Do you have a great plan that would improve the bottom line for your company? Or are you an expert who knows how to efficiently manage projects for other organizations? Whether you’re pitching a project to your own boss or selling the idea to another company, you’re going to have to put all your thoughts down in writing before you get the approval to proceed.

Many templates in Proposal Pack are perfect for describing projects. You can explain options and ask for input with the Choices template; show how you can make things better with the Improvement and Efficiencies templates; and prove you understand the process with the Dependencies and Execution templates, just to name a few. Other templates designed specifically for describing projects are Project Methods, Time Line, Requirements, Schedule, and Project Background.

See our online article [How to Write a Project Proposal](#) for more details.

Proposals for projects can run the gamut from a short internal project to a massive project that requires the cooperation of many different groups. We’ve included lots of different sample proposals to show you how Proposal Pack templates can be used.
HOW TO WRITE A GRANT FUNDING PROPOSAL

Government grants have very specific requirements, and Proposal Pack is designed to help you meet those. If you’re writing a proposal (NGO) for government grants, see the separate manual on Writing Government RFPs and Grants.

If you are putting together a proposal to compete for any other type of grant, Proposal Pack includes all the templates you’ll need. Just like in any other proposal, you’ll need to explain why you are best suited for the job. To do that, you’ll use general templates like Cover Sheet, About Us, Awards and Achievements, Approach, and so forth. Other templates that are specifically designed for grant proposals are Uses of Funds, Sources of Funds, Funding Request, and Future Funding.

See our online article How to Write a Grant Funding Proposal for more details.

Proposal Pack includes a number of sample proposals that provide you with ideas of what to include in your own funding request.
HOW TO WRITE A BUSINESS PLAN
FUNDING PROPOSAL

If you’re trying to start or grow a business, you may need to submit a business plan to request funding from an investor or lender. Proposal Pack includes all the pages you need to show that you’re organized and trustworthy.

As well as including general pages to introduce yourself, you’ll want to consider many of the specific financial templates, such as Financial Information, Cash Flow Analysis, Budget, Profit & Loss Statement, Funding Request and Repayment Plan, just to name a few.

See our online article How to Write a Business Plan Funding Proposal for more details.
HOW TO WRITE A BUSINESS OPPORTUNITY PROPOSAL

When you want to sell a business or an investment, or when you need to convince others that buying a business or an investment is a good idea, you’ll write a proposal that describes the financial worthiness of the investment.

To do this, you’ll use many of the financial templates included in Proposal Pack. For example, look at the Return on Investment, Financial Information, Cash Flow Analysis, Budget and Profit & Loss Statement to start with and select the ones most useful to you.

See our online article How to Write a Business Opportunity Proposal for more details.

To see how a business opportunity proposal might be organized for different types of enterprises, check out the sample proposals included in Proposal Pack.
HOW TO WRITE A RESUME

Writing a resume is writing a business proposal; you’re describing your strengths, offering your services and showing how the potential employer will benefit from your experience and abilities. Sometimes there’s a need to write resumes for people other than yourself, too, as is the case when you’re offering the services of one or more workers to others.

Proposal Pack includes many templates that are perfect for putting together a detailed resume: Employment, Credentials, Education, Accreditations, Awards & Achievements and Resume, just to name a few.

See the expanded online version of How to Write Your Resume as a Business Proposal for more details.

We’ve also included samples of different types of resumes and job proposals.
HOW TO WRITE A BOOK PUBLISHING PROPOSAL

If you have a great idea for a book, especially a nonfiction book, you’ll need to put together a book proposal to sell your idea to a publisher.

Proposal Pack has the templates you need. As well as describing the content of your book using templates like Outline and Treatment and describing yourself (and any co-authors) with the Authors Bio template, you need to show that you understand the market for your book. To do that, you could use Proposal Pack’s Needs Assessment or Market and Audience templates. Other templates you might want to use are Layout, Design and Packaging, just to name a few.

See our online article How to Write a Book Publishing Proposal for more details.

To see how you might use these templates and others, see the included sample proposals.
HOW TO WRITE A PLAN, STUDY, OR REPORT DOCUMENT

Have you been tasked with writing a plan for the organization’s future, a case study, or an annual report? Although these documents are not business proposals, they are similar complex business documents. These types of documents use the same Proposal Pack templates as business proposals, except that the ‘pitching’ templates are not needed because you are not selling a product, service or a project.

Check the list of templates included with Proposal Pack and you’ll find thousands to use in your document. For example, you may need to compare your organization with the competition using templates like Competitive Analysis or Market Share, do financial analysis with templates like Profit and Loss Statement or Cost/Benefit Analysis, and present your vision of the future with templates such as Planning and Future Developments. If the document you’re writing is long, you may need the various appendix templates, too.

See the following online articles for more details:

- How to Follow Up Your Sales Proposal with an Information Packet
- How to Write a Case Study
- How to Write a Feasibility Study

Proposal Pack includes samples of some studies and reports.
HOW TO WRITE A GOVERNMENT CONTRACT

Want to do business with the U.S. government? Then you’ll probably need to write a sales document for the General Services Administration (GSA).

Proposal Pack includes all the documents you need to put together your proposal. Naturally you’ll supply information about your organization and your products and/or services, as you would in any sales proposal. For that purpose, you could use thousands of different templates in Proposal Pack. For example, to provide background information for your company, you might use the Company History template, and then use the Products or Services Provided templates to describe what you have to offer.

In addition, because the information you need to supply for GSA contracts is very specific, we’ve provided special templates for government contracts: Cover Sheet (Government Contracts), Customer Information, Awarded SINs, and Special Attributes.

See our online article [How to Write a Government (GSA) Contract](#) for more details.

To help you get started with ideas on how to package your information, check out the sample proposals included with Proposal Pack.
HOW TO WRITE A GOVERNMENT GRANT PROPOSAL

Writing government grant proposals is very similar to writing general business proposals however government grant proposals will require you to adhere to specific guidelines, use some government agency supplied forms and worksheets and include some types of information not normally found in more freeform proposals.

Read the supplemental manual also included with your Proposal Pack titled Proposal Pack Users Guide to Federal Government RFPs and Grants.

There are also a collection of sample Federal government grant proposals included in your Proposal Pack you can use as a guide for how to map the agency RFP application guidelines to a set of Proposal Pack templates. Complete instructions on this process are outlined in the manual above.

Writing county, state and local government grants is very similar to writing Federal government grants. Use the same processes and instructions found in the manual mentioned above.

See the expanded online version of How to Write a Response to a Government RFP
There are sample research proposals included in Proposal Pack which show a general outline for how a research proposal can be assembled using the wide variety of templates.

There are a wide variety of financial templates you can use to outline the funding requirements of a research project.

There are also a wide variety of templates you can use to outline the technical or scientific requirements of a research project.

See our online article How to Write a Research Proposal for more details.

Proposal Pack includes samples to help you visualize how to use various templates in your document.
HOW TO WRITE A REQUEST FOR PROPOSAL (RFP)

Most documents written using Proposal Pack are free form proposals, grant applications, quotes, bids and proposals in response to an RFP. However, Proposal Pack can also be used to create a request for proposal or RFP document.

Important Licensing Note: While a company can produce an RFP to distribute among potential responders. You may not supply any other companies or individuals with any Proposal Pack templates for their own use in responding to an RFP. Any company using Proposal Pack templates to respond to an RFP must purchase their own license to use Proposal Pack content.

The graphic logo design versions of Proposal Pack also include an “RFP” and a “Request for Proposal” header graphic that can be used in place of the stock default “Proposal” graphic in the Title Page of your document.

There are also a wide variety of templates you can use to outline the requirements of an RFP.

For example, start your RFP document with the Title Page and Table of Contents, then add the Format template to outline what format you want the responding proposals to be written in. Then add templates such as the Project Background, Evaluation, Qualifications and so on.
Once you have decided all of the chapters/topics you want in the document assemble the template together into your master RFP document.

The stock default text in the templates us usually written from the perspective of the responder since that is the most common use of the templates. For an RFP you will rewrite the body text of the templates to request information. For example, you may fill in the Qualifications template telling the responders to outline their qualifications rather than filling it in with your own qualifications.

See our online article How to Write a Request for Proposal (RFP) for more details.

Proposal Pack includes samples to help you visualize how to use various templates in your document.
HOW TO WRITE YOUR PROPOSAL IN A FOREIGN LANGUAGE

Proposal Pack includes a number of new additions that support writing your documents in foreign languages.

The Proposal Packs include a copy of one of our stock sample proposals that has been translated into many different languages. These samples illustrate how the stock templates, background graphics, layout and design of the Proposal Pack is still used even when all of the text is translated to another language.

The body text of the sample was human translated. The Proposal Pack and Wizard software does not translate all of the text for you. To get the chapter headers to work with the logos the stock Proposal Pack graphics without text were inserted into the page headers and formatted to be positioned “Behind Text” in Word. Then a text object was inserted and positioned appropriately over the graphic. Into the text object the foreign language translated text was inserted and set to the same font color as is used in the actual graphic versions of the English language text.

A little extra manual work is required to create custom foreign language page headers when using the graphics versions of the Proposal Packs. You can see the final result in the collection of foreign language translated samples.
For users on the Microsoft Word for Windows platform you can also upgrade to the Expert Edition of the Proposal Pack Wizard software which includes automated translation support features. The Expert Edition of the Wizard software will automatically translate the page header and a variety of other short phrases commonly used in your documents. Note that the Wizard’s translation features do not translate all of the body text, only page headers and some specific short phrases.

See our online article [How to Write your Proposal in a Foreign Language](#) for more details.

Proposal Pack includes samples to help you visualize how to use Proposal Pack in various languages. All of these translated versions were human translated from the original English language Event Party Planner Services Proposal.
HOW TO INTEGRATE WITH PROPOSAL KIT

The Proposal Kit Professional comes with a non-logo design and layout version of the templates that is designed for you to customized based on your own company logo.

Most people using the Proposal Kit Professional also have a company logo and branding for their company already and use the Proposal Kit Professional features to create their own logo design version of our templates.

The Proposal Packs build on those templates by giving you professionally designed variations on those basic templates saving you the time of doing it yourself the first time.

If you are using both Proposal Kit Professional and add-on Proposal Packs you should use the add-on Proposal Pack templates for your proposals and use the Proposal Kit Professional for the non-proposal templates such as contracts, agreements, estimate spreadsheets and additional business development materials and the document assembly software.
HOW TO INTEGRATE WITH PROPOSAL PACK WIZARD

Proposal Pack is a collection of pre-designed editable documents.

The Proposal Pack Wizard add-on is our Microsoft Word plug-in software. Proposal Pack Wizard helps automate tedious tasks of proposal development and is for use with any of our Proposal Pack template collections.

See the Proposal Pack Wizard information on our web site at: https://www.proposalkit.com/htm/proposal-writing-software.htm

If you have one or more Proposal Packs and Proposal Pack Wizard first install all of the products on your hard drive. Then run the Proposal Pack Wizard and let it find your installed Proposal Pack templates. Then use the Proposal Pack Wizard to manage the process of selecting documents, copying them to client folders, managing contact information, changing border styles, merging contact information into templates, combining templates together, editing your proposal templates and more.

See the documentation included with Proposal Pack Wizard for more details.
HOW TO INTEGRATE WITH OTHER PROPOSAL SYSTEMS

You can use Proposal Pack materials with other proposal systems including proposal generation software and pre-written proposal documents.

Use the supplied graphics to add a new visual look and feel by importing the Proposal Pack graphics into proposals created by other systems.

If your new system does not have some of the templates we supply you can copy ours into your other system as needed.

Most proposal systems operate on Microsoft Word documents anyway so you should be able to import our content into virtually any other system.
HOW TO INTEGRATE WITH ALL YOUR BUSINESS DOCUMENTS

You can use Proposal Pack graphic styles to update all of your other business documents with a similar look and feel.

Read the section on creating your own graphic styles in this manual first. You can create page headers for any of your existing business documents such as invoices, documentation, client correspondence and more.

You will need to create custom graphics using our original artwork graphics included with Proposal Pack and your own graphics program.

For example, if you have an invoice document you currently are using and would like to have a page header in the same style as the proposal templates you can easily do so. First, open one of our existing graphics such as “ExecSummary.psd”, change the text from “Executive Summary” to “Invoice”, then save a copy in PNG format such as “Invoice.png”. Secondly, open your existing invoice document and import your new graphic using your word processor’s “Insert” > “Picture” > “From File” and then select your new file “Invoice.png”.

See the complete description of how to create custom graphics in this manual for further details.
HOW DO I CUSTOMIZE MY PROPOSALS FONTS?

Every template has been formatted so the text in all elements of the page (headers, footers, body text, and so on) is set to pre-defined Word “Styles”.

Word “Styles” are managed by your word processor and are supported by all major word processors (not just Microsoft Word). Read your word processor help manual for more information on how to change and use “Styles”.

By using Word Styles, you can instantly change all of the text in an entire document by modifying the font settings of the Word “Style”.

As you assemble multiple Proposal Pack templates together into more complex documents, the Word “Styles” are always retained.

The Proposal Pack Wizard software also supports these same Word “Styles” and allows you to change the font settings within the Wizard as well.
The following custom Word “Styles” are defined in every Proposal Pack template:

- **Proposal Kit Page Header** - Used for building automated Table of Contents and used in all page headers

- **Proposal Kit Faux Page Header** – The same font settings as above, but is for use in templates that will NOT be included in the Table of Contents

- **Proposal Kit Body Text** – Used for the main body text of paragraphs

- **Proposal Kit Important Body Text** – Used for the main body text of paragraphs that are highlighted in red text for important notes

- **Proposal Kit Sub Header 1** – Used to highlight larger font size header text

- **Proposal Kit Sub Header 2** – Used to highlight medium font size header text

- **Proposal Kit Footers** - Used for small text in page footers

- **Proposal Kit Fine Print** - Used for small fine print text

- **Proposal Kit Title Page** - Used for contact info text blocks in Title Pages

- **Proposal Kit Title Page Header** – Used for highlighted bold text in Title Pages

- **Proposal Kit Title Page Sub Header** – Used for highlighted bold text in Title Pages

- **Proposal Kit Table Text 1** – Used for reverse (white or light colored) text in a table that has a dark cell color background

- **Proposal Kit Table Text 2** - Used for reverse (white or light colored) text in a table that has a medium/dark cell color background

- **Proposal Kit URL** - Used for text that is defined as a website URL or hyperlink

- **Proposal Kit Pull Quote Text** - Used for text that is larger font type bold and emphasized typically for a short quote or statement that stands out
HOW TO SEARCH FOR TEXT ACROSS MULTIPLE DOCUMENTS

Since the Proposal Pack is a collection of documents and not a software application it does not include a search feature.

One tip for searching your Proposal Pack for a specific template or sample proposal is to click on the index of all editable documents or the index of all sample proposals. Then push the CTRL-F keys in your web browser. This will bring up your browsers “Find” option and you can search the entire list for a particular document. This feature only works for searching a single web page for text however.

If you want to search all of our samples (i.e. the entire library of Adobe Acrobat PDF samples) you can use Adobe Acrobat (either the full retail version or the free Acrobat Reader version).

Run your Adobe Acrobat program and find the File > Search or Advanced Search option on the Acrobat menu. The Search or Advanced Search screen will allow you to search across all of the Proposal Pack sample proposals for a particular phrase. This can be helpful if you want to find all of the sample proposals for example that use the “Assumptions” template so you can see an example of how that template was filled in. To search across all of the Proposal Pack samples browse to the install folder:

c:\ProposalKit\ProposalPack\[style name]\SampleProposals
You can also use this feature to search all of your own completed proposals to locate a piece of text or a client proposal you wrote in the past (assuming you saved your final proposals in PDF format).

To search across multiple Word documents (such as our library of editable Word templates) or your own client proposals you can use the built in search features of your Windows operating system. Using your Windows desktop, start menu or the search box in the top right corner of the screen when you click Word’s “open” menu you can enter a phrase to search for and options to search across document titles or within the text of a document. Consult your Windows operating system help for details.

You can also download 3rd party search tools from resources such as Download.com that can search across multiple files and file types.
ADJUSTING PAGE BORDERS IF NOT PRINTING

Some Proposal Pack styles have a colored page border included in the style. The page borders are completely optional to use depending on the look and feel you want to create for your own company. For example, the "Entertainment #1" style has a thin red border around every template page while the "Classic #1" style has no border.

On some computers your printer may not be able to print the lower part of the page border due to the unprintable border area defined by individual printer drivers. All page border issues are related to your word processor and your printer driver. See your word processor help manual and your printer driver for details on the unprintable border area of your printer.

To edit page borders in Microsoft Word:

- Click the "Format" menu option
- Click the "Borders and Shading" menu option
- Click the "Page Border" tab in the dialog box
There are a few options to alter the templates to change the page borders, depending on your printer and the style of page border, accent graphic sizes, etc. you may need to try a number of adjustments. The easiest option is to turn off the page borders as it will not detract from your proposal:

- Remove the page borders by clicking the "None" option in the dialog box.
- Remove the lower page border, or both the top and bottom borders, only keeping the side borders.
- Click the "Options" button, and then change the "Measure From" setting to measure from the text instead of the edge of the page. Also turn off the option to "Surround Footer". This may require manually adjusting the positioning of the page footer graphic. Use the "View > Header and Footer" option in Microsoft Word to make change to the document footer.
- Remove the document footer accent graphic and text (it may pull the border up into the printable area)
ADJUSTING PAGE FOOTERS IF NOT PRINTING

Most Proposal Pack templates have a footer which includes an accent graphic and your company URL. These are designed to be changed if you so desire. There is no rule that this information must be in the footer. For example, you can remove the footer, change the accent graphic to your own company logo, change the URL to your company name or remove it.

Various combinations of accent graphics, URLs and fonts as well as the addition of a page border (see previous page) can cause parts of the footer to not be printed. This is dependent on the printer driver as the printer driver on your computer defines the non-printable border.

After you have finished adjusting the footers to suit your needs check to see if the footers fall in the printable area. If any part of the footer is cut off you can try readjusting the footer.

In Microsoft Word, select the “Page Setup” option. Then click the “Layout” tab. Then change the “From Footer” setting. For example, if it is set to .25 inches from the edge, try setting it to .3, .4, .5 or .6 inches. Consult your word processor manual for specific details.

You can also try adjusting the settings in the “Format > Borders and Shading > Page Border” Microsoft Word dialog box options. Consult your word processor manual for specific details.
COMBINING TEMPLATES INTO A MASTER PROPOSAL

If you are using our add-on Proposal Pack Wizard software

- When creating your proposal project, select the check box "Combine templates into single master proposal". By default this option is always turned on.

- Your templates will all automatically be combined together into a single document called FullProposal.docx when you click the "Configure Documents" button in the Proposal Pack Wizard main interface.

If you are NOT using our add-on Proposal Pack Wizard software

- Complete the editing of all of the individual documents for your proposal

- With your first document open in your word processor

- Click "Import from File", select your file to insert, click okay

- Your word processor may change formatting of parts of the document

- Edit document as needed

- Set the page numbers and update the Table of Contents (if being used) This method is not recommended for large proposals as it can cause a lot of further hand editing of the final combined document. If you purchase the full version of Adobe Acrobat you can also convert your final proposal to a PDF file
and save and even e-mail it right from within Word. Some word processors also include a built-in PDF export option.

**Combining files using Adobe Acrobat**

- **Complete the editing of all of the individual documents for your proposal**
- **Set the page numbers as needed with "Insert Page Number"**
- **Update the Table of Contents**
- **Save all of the individual documents as PDF documents**
- **Run Adobe Acrobat (the full retail version - not the free reader)**
- **Open your first document (the PDF version)**
- **Either use "Insert Pages" or "Open as PDF" and pick each file in sequence**

If you are only printing your proposal in-house for delivery you do not even need to combine the individual proposal documents into a single file. Print each individual document separately. You only need to combine them into a master file if you are delivering your proposal digitally. If you are delivering your proposal digitally you should use a PDF format to prevent easy manipulation of the document, efficient transfer speed and for cross-platform compatibility. Editable documents with embedded graphics can be extremely large and may not display exactly the same on your prospects computer.
COMBINING COVER LETTER INTO A MASTER PROPOSAL

The Cover Letter template is a plain text document (i.e. no graphics or colored borders). Due to the way Microsoft Word works when you append documents together you need to take some extra steps to ensure the formatting of the entire document is maintained.

You can keep your Cover Letter as a separate document from the main proposal document. This is typically how it is used. You can also wait until after you have completely finished writing your Cover Letter and proposal, then use your PDF creator program (such as Adobe Acrobat) to combine them together as PDF files. This will retain the formatting of your proposal.

However, if you want to combine the Cover Letter (or any plain text document) as the first page of a proposal you need to be aware that you will need to make adjustments to the page borders, page numbering and the page footers to correct the formatting. These are all issues with how Microsoft Word works; they are not issues with the Proposal Pack templates.

If you cannot find any of the options or screens below, search your Microsoft Word help for assistance. This is all basic word processing.
Step 1

Open your Cover Letter template (CoverLetter.docx)

Step 2

Open the first graphic skinned template of the proposal (such as TitlePage.docx), or open the full combined proposal if you have already appended the rest of your proposal templates together.

Step 3

Position your cursor at the top of the TitlePage.docx (or combined proposal document), then insert a page break.

Step 4

Position your cursor at the top of the CoverLetter.docx template and then type Ctrl-A then Ctrl-C. This will select all of the text and copy it.

Step 5

Position your cursor back at the top of the blank page you inserted in the other document, then type Ctrl-V to paste the text.

Step 6

Now we have to clean up the formatting. In your Word menu, find Borders and Shading, click the Page Border tab, then select the Apply To menu option “This Section – All except first page”, then click OK. This will turn off the colored border if there was one on the pasted Cover Letter.
Step 7

In your Microsoft Windows, find the Page Setup screen and click the “Layout” tab. Check the box “Different First Page”. This will turn off the footer graphics in the Cover Letter and retain them in the rest of the documents that follow.

Step 8

If you have inserted page numbers they should start on the 2nd page of the document (after the Cover Letter). The final step is to adjust the page numbers so they start at 1, on the 2nd page. Find your Microsoft Word option for inserting page numbers and click the “Format Page Numbers” option, then set the “Start at:” option to 0 (zero). If you have not already inserted page numbers, you can then insert page numbers. To avoid having Word delete your Proposal Pack documents graphic footer, insert the page numbers in the “Page Margins” or “Current Position” (not the “Bottom of Page”) of the document.
CREATING AN AUTOMATED TABLE OF CONTENTS

The Table of Contents included in the Proposal Pack templates is a Manual Table of Contents. This means you have to manually update the page numbers and entries as you alter your document (i.e. adding chapters and pages). If you purchased the Proposal Pack Wizard add-on software, the Wizard can be used to create a Table of Contents from the selected templates.

The pre-assembled documents that come with each Proposal Pack also include automated Table of Contents that will auto-update as you change the document. You do have to tell Word to update the Table of Contents, but Word will do the renumbering and changing of the listed chapters for you.

Microsoft Word has the ability to create an Automated Table of Contents. Follow these steps to create an Automated Table of Contents which will allow you to automatically add new chapters to your Table of Contents and update the page numbers.

The Automated Table of Contents is a feature of Microsoft Word, not Proposal Pack. The instructions outlined below are basic Word processing steps. Depending on your Word processor version and platform some steps may be different. If you have specific questions about automated Table of Contents and font Header styles referenced below, search your Word processor help for that topic.
Step 1

Combine all of your selected Proposal Pack templates into a single document first.

Step 2

You have to create the headings for each chapter in a format that Word will be able to recognize as a Table of Contents chapter. This means the title of each page has to be in a specific Word font style.

Your Proposal Pack templates will be in one of two types of templates.

If you have “Proposal Pack for Any Business” or “Proposal Pack for Government Grants” this is easy. Every Proposal Pack chapter template has the title of the page in text in a large bold blue font. For example “Executive Summary”, “Cost Summary”, “Company History”, etc.

Highlight this text in each page then in your Word toolbar find the font styles and click the style called “Heading 1”. Your Word program will probably have different font settings for the “Heading 1” style than our templates page header text. Click the Modify button for the “Header 1” style and change the page header font settings to whatever settings look good to you. You can change them any way you like.

If you have any other Proposal Pack product which includes graphic designs in the page headers it will require a little extra work to create an Automated Table of Contents. Why?

This is because Microsoft Word can only create an Automated
Table of Contents using text page headers, and all of our Proposal Packs with design themes use embedded PNG graphics for the page headers. What this means is that if you see the title “Executive Summary” in your Proposal Pack template it is not actually editable text in Word, it is a picture. This means Microsoft Word cannot interpret that text to use it in a Table of Contents. To get around this for an automated Table of Contents you have to add that text under the graphic. For example, directly under the picture with a logo that says “Executive Summary” you have to type the actual text “Executive Summary”.

Now, you have to highlight that text and set it to the Word font style called “Heading 1”. At this point your template will have both the graphic and the text showing, so now you have to make the text you just added hidden from view. Click the Modify button to change Word’s “Heading 1” font style and set the font size to the smallest number (i.e. 8), and set the font color to white. This will make all the headers disappear from sight, although they will still be in your document. You also want to make sure you haven’t used this “Heading 1” font style in the content of your proposal otherwise that content will disappear from view as well.

Another (and newer) method of generating an automated Word Table of Contents using graphics as chapter headers is to add hidden “TC Fields” in front of the page header graphics. You can see this hidden fields when you click the paragraph button on your Word toolbar. The latest versions of Proposal Packs use this method and the hidden “TC Fields” are already embedded in all of the Proposal Pack templates. The Wizard software also creates these “TC Fields” for you if they do not exist already in your templates.

When you manually paste new pages into a pre-assembled
document and you are using a logo version of a Proposal Pack and you are using an automated Word Table of Contents make sure the “TC Fields” are correctly maintained at the header of each chapter page. Since these “TC Fields” are normally not visible it is easy to delete them or not copy and paste them when you are editing your documents.

**Step 3**

Now that you have all the headings created in a format that Word can recognize as Table of Contents chapters you can add the Automated Table of Contents.

Position your cursor at the top of the Table of Contents template that has the Manual Table of Contents in it. Delete the Manual Table of Contents content. Now you have a blank page in your Table of Contents Proposal Pack template. Now click the Word toolbar option to insert a Table of Contents. You will see multiple options; select the Automated Table of Contents. You will now see a complete Table of Contents created matching all of your Proposal Pack templates with the matching page numbers.

**Step 4**

Sometimes the Word Header font styles are used in the content of pre-existing templates and content you may have pasted in from other sources. When creating a Word Automated Table of Contents the first time you may have to reformat parts of your proposal if unexpected lines show up in the Automated Table of Contents.
EASILY CREATE YOUR OWN GRAPHIC STYLE

The Proposal Packs are designed to be used as-is with professionally created layouts and graphics. If you are in a hurry to create a proposal as many of our users are, you do not need to create your own custom graphics to use the Proposal Pack materials. You can also modify our styles for your own personal use by creating your own custom variations on the graphics as follows:

All of our template material is copyrighted and on file with the US Copyright Office. You may only create custom variations of this material for your own business or personal use. Templates may not be distributed as templates, resold or otherwise posted. Only your final proposals may be distributed to your clients or internally within your company using Proposal Pack and Proposal Kit material.

Open any one of the existing Adobe Photoshop (.PSD) or Adobe Illustrator (.EPS) graphics to start with (for example, "ExecSummary.PSD". Or, if you do not have either of these programs, just open the PNG version of the "Blank Template Header (without text)" graphic from the graphics list below. The file name installed on your hard drive is "PageHeader_NOTEXT.png".

From within your graphics editor with the select graphic opened, edit or erase our default graphic and replace it with your own company logo or graphic of your choice.

Resize the graphic if needed to fit. Do not make it too large otherwise it will be too large when embedded back in the
Save your default graphic for your new look, without any text as a backup.

Now, go down the list of page header titles for the graphic titles text and copy the first title. We include 3 different styles depending on the visual effect you want (mixed case, all lower case and all upper case). Then create a text element in your graphic, pick a font, font size and color to match your own style and adjust the layout until it is exactly what you want. See the bottom of the web page organizer on your desktop for the Proposal Pack Organizer for a complete list you can cut and paste from.

Save your layered image as a backup.

Save a copy as a 120 (or higher resolution) dpi PNG file.

Print a paper copy of the .PNG version as a test to make sure it prints high quality.

Now, go down the list of the graphic titles text and one at a time: copy a piece of text for a title, paste it into your text element in your new graphic, save a copy as a .PNG file and a backup .PSD file (or you can combine them all into a single layered graphic depending on your graphics program and how you like to save your work).

Now you are done creating your header graphics. Once you create your initial header for your own custom style, you can create a whole suite of custom headers in just minutes.
In your documents highlight the header graphic, delete it, then click "Import from File" in your word processor’s toolbar, pick the new graphic you just created and your new header will be inserted. Do this for each of the stock templates you will be using. You may also at the same time change other elements such as colors of bullet points, change the color of the page border (or remove the page borders).

If you do not have the time or ability to create your own custom graphic headers we offer custom graphic editing services at:

https://www.proposalkit.com/htm/service.htm
TROUBLESHOOTING

We do not provide technical support for 3rd party applications such as word processors, web browsers and operating systems. Please consult your manuals or 3rd party software providers for assistance.

Q: Where are the files on my computer?

When first installing the Proposal Pack, you were prompted to choose a location for installation and all associated files. This is where files are located. No desktop icon or application is launched during installation. All templates and graphics are contained on your hard drive in the original folder you chose. The default install folder is:

“C:\Proposal Kit\Proposal Pack\[the style of pack]”

Q: Why is the border not printing?

Your printer has a non-printable border. The size of the border is defined by your printer and driver and can be adjusted using your word processor options. The borders in the templates (if used) are standard borders (see your “Borders and Shading” option in Microsoft Word). Your options are to turn off the borders, adjust the border settings and/or adjust the page footer accent graphic and other trailer tags and positioning. Consult your word processor help for specific details.
Another option is to (in Microsoft Word) click Borders and Shading, then Page Border, then click Options. In the Options dialog, pick “Measure from Text” from the drop down measure field, then uncheck the “Surround Footer” box. This will cause the page border to fit closer in on the page and on top of the footer. If the border is now too close to the text, adjust the top/bottom/left/right fields to higher numbers until the border prints on your printer on all sides without overlapping the footer or anything else. Consult your word processor help for specific details.

**Q: I don’t have an Internet connection. How do I use it?**

The materials are all installed on your hard drive and there is no need to have an Internet connection when using the Proposal Pack. Any web site links included in the material are either optional or for information purposes only.

The HTML browser organizer is a page residing on your desktop with links to the documents and graphics also installed on your hard drive. Just because your browser is accessing an HTML page on your desktop does not mean you have to connect to the Internet.

**Q: My computer is locking up using the Proposal Pack?**

This is commonly one of two situations, both related to your system and not a fault of the Proposal Pack. The Proposal Pack materials are standard documents, graphics files, HTML pages and PDF documents and do not cause system problems.
Over time your computer may be having its memory fragmented by running numerous programs, this can happen very frequently or over the course of hours depending on the system. Low memory conditions caused by fragmentation (regardless of how much RAM you have installed) can cause problems with any running software such as your word processor. Close everything and reboot your computer to free up resources lost to memory leaks caused by the various software running on your computer.

Another possible cause is launching the web browser version of Microsoft Word which can happen when you click a link in a web page to a document. In some cases a web browser version is run which may have memory problems. Run Microsoft Word by itself first instead of clicking the document links in the web browser interface, and then open the Proposal Pack documents. You may want to do this anyway as you will have access to all of Microsoft Word’s features. You can also use the Proposal Pack Wizard add-on software instead to launch your documents as it is designed as a Microsoft Word plug-in and works directly within Microsoft Word.
Successful proposal writing requires much more than just filling out some documents. There are many issues that can affect how successful you are, such as:

- Using just the right wording
- Pitching to the right person
- Making the pitch at the right time
- Using proper spelling and grammar
- Addressing the prospect’s fears and objections
- Personal appearance and presentation
- Internal politics at the prospect’s company
- Hidden agendas at the prospect’s company
- How many proposals you send out
- Having a right price, not necessarily the lowest price
- How persistent you are with the same prospect
- How you stack up against the competition on various levels
- Miscommunication between parties
- Competitors trashing your solution in their proposals
- A consultant at the client with ties to one of your competitors
- The prospect wants the “safe” choice, not the “best” choice
- And so on...

See our appendix of resources page for recommended books on proposal writing that cover these topics and more in detail at:

https://www.proposalkit.com/htm/append.htm
PROPOSAL DISTRIBUTION

Print, e-mail and web-based delivery are several ways in which to distribute a proposal. Proposals should always be delivered in print and then optionally followed up with an e-mailed version in PDF format.

Digital delivery may be fast and convenient but it still does not beat a high quality printed and hard bound copy delivered directly to the client.

Print your proposals on high quality paper using a quality printer. Insert into a quality binder and ship priority overnight unless personally delivering it. Never use cheap, flimsy paper or staples. Also print and bind enough to give each person reviewing your proposal his/her own copy.

If you cannot avoid sending a digital proposal, purchase a copy of Adobe Acrobat and save your full proposal as a single Adobe PDF file which can be easily e-mailed. Your client will be able to view it on any platform and can print it out as well.

See our appendix page at https://www.proposalkit.com/htm/append.htm for recommendations on binding resources and books that will go into much more detail on proposal distribution.
TIPS AND TRICKS

You will stand a better chance of winning proposals if you take the time to create client-centered proposals specific to each client rather than recycling old proposals and just changing the client contact information.

Avoiding writing a lot of fluff without saying anything and keep the proposal easy to read. Our templates are designed to use lots of bullet points for easy reading and is a major reason why we do not include a lot of generic pre-written content. This is especially important when submitting a proposal where there are many bidders, yours should stand out as being easy to read and understand.

Try filling out all or most of the relevant templates for each proposal even if the final proposal will not include all of them. This exercise will help uncover things that may have been missed and can help improve the final proposal.

Spell and grammar check your proposal and also have it reviewed, if possible, by someone not close to the chalkboard. If it is in your budget, hire an editor.

Judge your proposal size by the size of the project and prospective client. For example, a $300 Mom & Pop static web site might only be 2-3 pages. Don’t hand them a 30-page proposal. A larger corporate or government project may require a 40 to 100 page proposal or more. Handing them a 5 page proposal will most likely not get you the job. There are no rules as to the size of the proposal or what sections to use. Let common sense, study and experience be your guide. Also consider hiring an experienced proposal writer if possible, to assist.
What if you don’t get the job? It is to be expected the more proposals you write the more you will lose. You must be able to fine-tune your proposals over time. Whenever possible, interview the prospect when he/she declines the proposal to find out why you were not chosen. Then adjust your business and proposal writing as needed to improve your chances on the next proposal.

Do not include extraneous information. If you have multiple products or services, include only those that relate to the client’s needs. If responding to an RFP, follow their guidelines and only include the proposal sections requested. If you need to add sections or change section titles, use the original graphics supplied with the Proposal Pack to create new graphic headers.

If you are responding to an RFP which includes instructions on how to submit the proposal you must follow the instructions to the letter. If you deviate from the instructions even the most minor alteration can cause your entire proposal to be disqualified. If the instructions say there is a 10 page limit, do not send 11 pages. If the instructions say not to include collateral material, do not send your product brochures. Also strive to make it very easy for the proposal reviewers to find all of the information required in the RFP and make that information easy to read and understand.

Don’t give away the farm in the project section of the proposal. If you give up too much specialized knowledge in the proposal and design, your prospect could take your up-front design and give it to a lower bidder. Keep the proposal manageable. You may have pages of development checklists and steps; keep the actual steps short and digestible in the actual proposal. See our Proposal Kits for pre-contract agreements for web professionals to protect your upfront proposal designs if they are very
involved. The Proposal Pack does come with a basic non-disclosure form you can use to also help protect your work.

Make sure to include a financial incentive in the proposal for choosing you for the job. Use the templates to demonstrate how using you will have positive financial effects on the client’s business. There are sections in various templates to add this information (e.g. the Executive Summary or Expected Results).

Do not underbid a project. Do not bid on projects you cannot complete. You may be responsible for completing them regardless of your capabilities. Learn when to pass on a project and when to accept projects that will allow you to definitely make a profit.

Your odds of success may increase as you specialize and specifically target a niche. See the various Proposal Packs for styles and designs specifically tailored to appeal to specific niches. You may want to consider becoming a specialist in certain areas.

Pick a style and design for the Proposal based on the prospective client’s preferences. For example, if you have a very conservative prospect, use one of the Classic styles, not an Artsy style. If you are not sure, play it safe: use a Classic style.

Be persistent – some of our biggest deals took six ‘not interested’ brush-offs by the prospect before they actually became a client on the 7th try. Many times a “no” is really just “no – not right now”. The more expensive or complex the service or product, the more you need multiple follow-ups to clinch the sale.
If possible, sell yourself to the “right” person such as a C-Level, VP level or President. Managers and gatekeepers may screen you for many reasons.

The Proposal Pack templates are designed on purpose with minimal pre-written text as most of what needs to be entered is content specific to your company, your project and your client. The templates are designed with many bullet points and clearly defined sections of information. This approach minimizes the “fluff” content and helps you create an easy to read and more importantly an easy to skim document. Make as much use of the bullet points as possible and keep the generic fluff to a minimum. Make your point clearly and concisely and do not waste the readers time with a lot of “words” that really don’t say anything. Time is more precious than ever for busy executives and decision makers, your proposal will be more appreciated if it comes to the point quickly and is easy to follow and easy to read.

Focus on the key benefits to the client and back them up with the reasons why your proposal should be chosen. The proposal should be predominately focused on the client, not on yourself. Our layouts are designed to put the client information first, the project information second and your company information last.

Use a lot of summaries and bullet points in the proposal. Summarize what you will say in the Executive Summary, provide details in sections that follow, and then use the Project Summary to summarize what you told them. If there are multiple layers of people between you and the ultimate authority who will accept the proposal you will have to write in a way to get past each layer. Gatekeepers and busy executives may only read the summaries. If it passes the first reviews it may be turned over to other individuals who will read the details.
Repeat the most important selling points outlined in the Executive Summary throughout the proposal. Repetition will make the point stick. Do not just type the same sentences over and over however. Repeat your key points by rephrasing them in the context of each section of the proposal. The key points should revolve around the client’s needs, your benefits and how your benefits will meet or exceed those needs.
IT’S ALL ABOUT TRUST – WINNING PROPOSALS BY FIRST WINNING TRUST

It’s a big impersonal world out there, especially on the Internet. The competition for attention is fierce. Anyone can slap together a price quote and a cover letter and ship them off via email, but that’s not a strategy that’s likely to succeed.

So how do you create a proposal that will land your next customer or secure your business loan or grant money or get your project approved? We all want to do business with people we trust. Your proposal must convince readers that you are worthy of their trust.

If possible, add a personal touch by requesting a face-to-face meeting to present your proposal. Shaking hands with the other party can go a long way toward finalizing a deal. But in-person meetings are not always possible, especially in the world of global business, so often your printed proposal needs to do all the work for you.

How do you inspire trust? And particularly, how do you inspire trust in people who don’t know you at all?

First of all, demonstrate that you have integrity and experience. To do this, provide honest, easily understood information about your background, your strengths, and your intentions. To do this with Proposal Kit, you could use the Company History, Credentials, Capabilities, and Awards and Achievements templates to describe yourself or your organization. Use concrete, straightforward language to describe how your proposal will benefit everyone (Opportunities and Benefits templates).
Clarity is important. Be sure to set forth clear expectations that both parties can understand, with results that can be measured. You may want to use the Goals and Objectives or Expected Results documents to provide a concise summary, and then use other pages to supply more explanation. Be as detailed as possible to ensure that you and the reader have a shared vision of what you are proposing. If you are responding to a request for proposal (RFP), show your thoroughness by carefully considering the information provided and by specifically addressing each requirement. If you are unclear about any requirement, get more information if possible so that you can include appropriate data instead of vague generalities.

In every proposal, you should encourage feedback from the other party, and explain that you are willing to listen and modify plans as needed to make the project successful for everyone.

Show your ability to complete the proposed project by explaining how and by whom the process will be accomplished. Proposal Kit products contain many templates you can use for this purpose, such as a Project Plan, Implementation Plan, Schedule of Events, and so forth. Describe the resources—such as equipment, financial backing, or experienced personnel—that you will employ for the project (Equipment, Facilities, Financial Information, and Personnel, just to name a few templates you might use).

Be thorough. Demonstrate that you understand the complexity of the project under consideration. If blueprints, diagrams, or photographs would demonstrate your ideas better than words, be sure to add those (using templates such as Blueprints, Diagrams, Illustrations, Samples, etc.)
Establish your reputation by listing similar projects you have finished and recommendations from your satisfied business partners (Company History, Testimonials, Referrals, and References templates). If you have copies of complimentary newspaper or magazine articles about your company’s projects or history, you might want to include those as well.

We are all more likely to trust others who hold themselves accountable for their actions. Legal contracts generally spell out the terms of accountability, and Proposal Kit contains many different types of contracts that you can adapt for your needs. You can also show your accountability by explaining how and when results will be analyzed. Some of the many templates available for this are Accountability, Testing Plan, Evaluation, Acceptance Criteria, and Reporting. Describe what you will do if wrongs need to be righted or the process needs to be changed. You might offer a guarantee of satisfaction or a warranty to fix any defects in a product—Proposal Kit includes Guarantee and Warranty templates for that purpose.

If you are already allied with respected brands or organizations, highlight that (Brand Strategy or Strategic Alliances templates). Memberships in organizations with good reputations can go a long way to establish respectability—be sure to list any you belong to on the Accreditations template.

If it’s appropriate, you may want to demonstrate your loyalty to good customers by providing a volume discount or other special offer. The Discounts template can be used for those descriptions.
Finally, we all tend to trust organizations and people who are good citizens. Do you donate to charity, lead a nonprofit organization, or lend a hand in your community? If so, point that out using the Donations or Contributions templates. Have you won any awards or experienced any publicity for your good deeds? Include any evidence that shows you are a contributor to a cause larger than your immediate organization.

Presenting a proposal package that is full of errors will make even the best plans look unprofessional. Whenever possible, have others review your proposal and provide feedback, and get someone with a good eye to check your final version for grammar and spelling errors. Before you ship off the proposal, ensure that all pages are numbered appropriately and all pieces are present and in order. Prospective partners will have more confidence in your ability to complete a project when you show that you are professional in your planning and presentation.

Above all, be polite and show your respect in your Cover Letter by thanking prospective business partners in advance for their time and consideration and inviting their questions and feedback on your presentation. You may want to send a handwritten thank you note and follow up with a phone call.

Use every aspect that your Proposal Kit product offers to help establish your credibility and dependability with your prospective business partners.

**Because it’s all about trust.**
BOILERPLATE IS BAD FOR BUSINESS – TEMPLATES WITHOUT THE FLUFF

It used to be that most business was conducted in person, or at least over the phone. Odds were that your prospective clients knew who you were, and your competition was local—you knew who they were, too. In that environment, it was possible to distinguish yourself from the competition by your personality.

Now our world is global and connected mostly by impersonal means via email and the internet. Whether you’re vying for a job, trying to secure a loan or a business contract, or reaching out to new customers, odds are that your competitors will be many and they can come from anywhere.

Many of our competitors’ products feature proposal documents with a great deal of boilerplate text; their pages encourage you to ‘fill in the blanks’ with your own information. This results in proposals that contain a lot of fluff but deliver little useful data. And worst of all, the proposal ends up looking and reading like hundreds—if not thousands—of others. This greatly increases the odds that the proposal will end up in the slush pile instead of on the decision maker’s desk.

Proposal Pack takes a different approach from this ‘fill in the blank’ style. Instead of giving you paragraphs of essentially meaningless boilerplate text, we provide you with instructions, constructive suggestions, and examples of appropriate information to put into each proposal page, as well as a professional format you use to present your ideas. The words come from you, and so does the tone and style of your presentation.
You’ll never be perplexed about what to add to your proposal when you’re using Proposal Pack. We have thousands of template pages for you to choose from, and hundreds of suggestions on how to connect those pages and elaborate on important topics. Proposal Pack also includes over a hundred sample proposals from a wide variety of organizations for all sorts of situations. By exploring these samples, you’ll see how our templates can be easily used and assembled into a unique package.

You want your proposal to showcase your ideas, show your personality, and stand out from the crowd. Those are our goals, too. When you use Proposal Pack, your proposal will be easy to write. You’ll feel like an expert as you put your information on the pages. Your finished product will be well structured, easy to read, and best of all—it will be a proposal that actually represents you.
STAY OUT OF TROUBLE COPYING PROPOSAL EXAMPLES

Why you should not copy someone else’s proposal example. A Best Practices article to help keep you out of trouble when you are writing your business proposal.

From a Proposal Kit article by Pam Beason:

I received a packet of information recently in the mail. The introductory letter started off like this:

Dear Mr. Beason,

We know you sometimes need temporary office help at WildWing Press. Did you know that you can hire a construction worker for just a day to handle the extra work? Our temporary service is here to give you help when you need it. We’ve enclosed a list of available services and prices, as well as information about some of our staff. After you’ve had a chance to read through our offerings, we’re sure that you’ll call Hard@Work Temps to learn how we can make your life easier.

As a business owner, I file packets like this in my recycle bin. Why? Because I can tell that this is only a copy that is going out to thousands of other business owners. For one thing, I have multiple business licenses, so I got multiple copies. But even if I hadn’t, I could tell that the sender has substituted only a few words—my last name, the word “office,” and the name of my company—because he forgot to change the font so all the text would match. The sender clearly hasn’t bothered to check that I am a ‘Ms.’ not a ‘Mr.’ And most telling of all, the sender forgot to take out the word
‘construction,’ and why would my publishing company need a construction worker? Does Hard@Work even employ construction workers, or is this a copy of another company’s proposal or proposal example that they found on the internet?

I recognize that the person who created this proposal was not a writer but a copier. I have no doubt that Hard@Work Temps is sending the same package to thousands of other companies. As a matter of fact, I’m sure I’ll discover exactly that when I get together with local business owners at our next networking meeting.

Did receiving this packet inspire me to use the services of Hard@Work Temps? No way. It makes me think that if the company is this lazy and careless in sending out proposals, they’ll probably be that lazy and careless in all their business dealings.

I’m a professional writer and editor, and of course I re-use formats, proposal examples and basic information where it’s appropriate, but I start from scratch when I write and I always proofread carefully to make sure that everything I’m sending out represents me and is intended for my specific client. Copying someone else’s proposal would be like copying someone else’s homework—it’s not ethical and it’s certainly not professional, and some telltale sign is bound to be left—mismatched writing styles, the wrong word, a name that doesn’t belong.

Proposal Kit is designed around best practices, and one of those is that copying samples and proposal examples is not recommended. Any professional will tell you the same thing.

Proposal Kit gives you all the tools you need to create good proposals and other business documents. The editable proposal
templates are full of suggestions and proposal examples for you to follow. The sample PDF proposal examples are not editable, but they provide you with great ideas of how to create your own proposal. Take those ideas and do what the sample writers did—use Proposal Kit’s templates to generate your own unique proposal.

Proposal Kit gives you a big head start, but you need to do the work of creating a document that represents you and is designed for your specific audience. A copied proposal or proposal example just won’t cut it when your proposal is not the only one on the client’s desk. If you are absolutely in love with a proposal example, you can copy and paste the text from the PDF file, but you run all the risks I mentioned above.

The competition’s tough out there. Use Proposal Kit’s features to create your own personalized proposal. Then at the next networking meeting, instead of laughing about the latest crummy copy they all received, your clients and potential customers will be raving about your fantastic proposal.
WHY YOU DIDN'T GET THE JOB

Writing a winning proposal is much more than just filling out documents and putting it in front of a prospect. There are many reasons why companies do not make the final cut. Learn from each proposal and adjust as needed. If possible, interview the prospect to find out why your company was not chosen. Just keep in mind you may not actually hear the true reason.

See the expanded version of this article online: 20 Reasons Why You Didn’t Win the Project

Failure to land the job may be for some of the following reasons:

- Writing style: yours did not appeal to the reader.
- Incorrect target: your proposal was not sent to the right person.
- Bad timing: your pitch was not made at the right moment.
- Slipshod writing: your spelling or grammar was incorrect.
- You failed to address the prospect’s fears and objections.
- Your appearance and presentation did not match the prospect's 'style'.
- Internal politics at the prospect’s company influenced the decision.
- Hidden agendas at the prospect’s company influenced the decision.
- Your project estimate was too low or high.
- You were too persistent or not persistent enough with the prospect.
- Your proposal didn't instill confidence.
- Your proposal did not show a clear understanding of the client's needs.
- Your solution was not the best value for the price.
- The competition outdid you.
- There was miscommunication between you and the client.
- Competitors trashed your solution in their proposals.
- A consultant working with the client had ties to one of your competitors.
- The client wanted the “safe” choice, not the “best” choice.
The RFP was written to favor a particular bidder.

See our recommended resources for books that explore these topics further:
https://www.proposalkit.com/htm/append.htm
OTHER RESOURCES


See our online article library for up-to-date articles on proposal writing topics.